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Computer Science in the school curriculum deals with computers and their

applications. Today, irrespective of geographical, economic and social parameters,
computers have become an integral

_ part of our lives, The fast pace of advancing
technology coupled with the numeroue fiolre ;

subject. Simple language, real-life ¢
activities, information and facts make t

This series focuses on— Windows 7,

onnections to explain abstract concepts,
he entire learning experience lively and fun.

MS Office 2007, MSw Logo, Tux Paint, QBASIC,
Flash CS3, HTML, Visual Basic 2008 and Internet,

Lesson Extract outlines the objectives of the chapter.

Chapter Content starts with an engaging introduction. The
text is supported with pictures and relevant screenshots.

For your Info (Information) gives extra and useful information
for memory reinforcement.

® Time to Drill interspersed within each chapter to check the

alertness of the students.
r

@

Lab Visit provides more activities that can be done in the lab.

Test Papers provide sample questions to assess students
understanding of the concepts learnt.

A series that will prove to be a treasure house for overall digital
development.
We expect that Computer Concepts will help students make computers their

Digital Buddy and useful in all real-life situations. We look forward to your response
tothe series andto any suggestions you may have to improve the same.

~The Publishers
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Know Your Compuﬁzr

= Computer System
- Input Devices
+ Qutput Devices

< Processing Device
» Computer Memory

COMPUTER SYSTEM )

A computer is an electronic machine that works on electricity. It is a smart ‘
machine which can be compared to a magic box that can do a variety of jobs. It

works on the principle of Input—Processing—Output (IPO) cycle. This can be
understood in the following way :

Ittakesindataand | | It stores and It gives meaningful
instructions that we @, | processes the W results using the
feed intoitusingthe | = | instructions we | output devices
input devices | feed into it

b e o = EESSERRE S —

Working Cycle of a Computer

A computer system mainly consists of hardware and software devices.

All the physical devices of a computer that we can touch and see are called
computer hardware.

Software is a set of instructions that helps the hardware to work in a desired
manner.

Hardware and software are interdependent. Without software, a computer cannot
work. Similarly, if hardware is not there, software is of no use. Based on the
functions of the hardware, they can be divided into different categories as input
devices, output devices, processing device and storage devices.

INPUT DEVICES

Input devices feed information, data and instructions to the computer. The
computer accepts and processes them before giving the output. Here are some

common input devices : B
‘ Book-4
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most common input device used. It allows the user 1o ;-
d other characters into a computer. A standard keyboard ;.
can be divided into -
Typing keys (Alphabet
d Numeric keys), Function
| to F12), Navigation keys
ys, Home, End, Page Up,
n, etc.) and Control keys
t, Windows logo key and

Mouse

A mouse is a hand-held pointing device with
two or three buttons on its top. It is used 1o
control the movement of a pointer. It is also
used to point and select the objects and open

Optical Mouse files/folders. Two basic types of computer
mouse are : Mouse with roller ball and

optical mouse.

Mouse with

‘ Roller Ball

S 2 For Your I Hgo

p A roller ball allows the mouse to move on a flat surface. An optical mouse uses
A + light to detect the movement of the mouse.

Graphic Tablet

A graphic tablet helps us to insert hand-drawn
images into the computer directly. We use a stylus
to enter them. It is mostly used to enter digital

signatures.

Microphone
A microphone is an input device which is used to record
voice, music and sound into the computer system. Sound
cards enable the computer to record sound input from a
microphone connected to the computer.

Book-4
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Touch Screen

A touch screen is a computer screen which is
sensitive to touch. We can select the objects
directly by touching with fingers without using
e.g, ATM machines,

any pointing device,
cellphones, etc.

Web Camera

A web camera is a device connected to the computer
for capturing still images and live videos. It is
primarily tised to share pictures and have live chat
with our friends and relatives using internet.

A light pen i1s a pointing device shaped like a pen. It is
connected to the VDU (Visual Display Unit). It is used to draw
pictures or to select menu options. It is easy to use as it is held
like a pen. It can be used in place of a mouse to select options
and make drawings or graphics on the screen.

Touch Pad

Touch pad is used instead of a mouse on the laptop
computers. It is a touch sensitive pad. You can control
the movement of the pointer on the screen by moving
the finger on the touch pad.

Digital Camera

A digital camera records images in a digital form
which can be stored in a computer. These images in
the camera can also be printed. These days, digital
cameras are also used for video recording.

Joystick

Joystick is a vertical handle which can be moved forwards,
backwards and sideways to control a machine. It is a
pointing device that works like a computer mouse as it is
used in moving the pointer on the computer screen. It

provides a good control when we play computer games.

‘ Book-4 a
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Scanner
A scanner is a device that helps to put printed pictures and illustrations iy, ,

computer. The scanner reads the images and translates the information i,
form that the computer can use. There are mainly three types of scanners - | 1?._,

bed, Sheet-fed and Hand-held.

-Flat-bed Scanner Sheet-fed Scanner Hand-held Scanner

Barcode Reader
A barcode is a set of lines of different thicknesses that
represent a number. Most packed products in shops have
barcodes on them.
A barcode reader is used to read the barcode given on a
product and feed the information into the computer. The
number is then used by the computer for preparing the
bill with the relevant details of the item including name,
quantity and price.

Biometric Sensor

A biometric sensor is used to recognize
individuals based on their  physical or
behavioural traits. It is used to mark the
attendance of employees and students in
organizations and institutions respectively. It is
also popular as a security device to provide
restricted entry for secured areas.

OUTPUT DEVICES

The devices that display result or information are called output devices. This
information is displayed on the monitor. It can also be printed on paper using a
printer.
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y Unit (VDU). The images that we see on the monitor are made up of tiny

' dots called pixels. The clarity of the images depends on the number of dots on

the screen. The colored images we see on the monitor are because of the colored

pixels. There are three types of monitors available : CRT (Cathode Ray Tube),
LCD (Liquid Crystal Display) and LED (Light Emitting Diode).

4 7) For Your Iﬂgﬁ‘
8 LED monitors have

v the advantage of

' being much thinner,
lighter and

' consuming less

CRT Monitor LCD Monitor

LED Monitor

Printer

A printer gives the output on paper. There are mainly three kinds of printers :
Dot-matrix, Inkjet and Laser.

Dot-matrix Printer Inkjet Printer Laser Printer

The dot-matrix printer works like a typewriter. The printer head strikes the paper
and the ink ribbon to print characters. It is also called the impact printer. This
printer is slow and noisy but economical. The inkjet printers are called non-
impact printers because there is no contact between the printer head and the
paper. Printing is done line by line by spraying ink on a sheet of paper. These
printers are much faster than the dot-matrix printers. They are more expensive
and consume more ink. Ink cartridges are used in inkjet printers.

The laser printer uses laser beams and  g2) For Your In.@o

dry lnk to print. It is mostly used in The output that is displayed on the
publishing houses. It is very fast and ® monitoris called the soft copy.
gives high quality output. It works likea | The printout from the printer is

photoct)pier. E. e .Cgl_]_elq_t,h_e,h_a_r_d_c?})y._ e




cial-purpose output device, It is
- quality drawings, It is
top publishing offices.

Speakers
Speakers are the output devices used 1o 1y
music and sound effects from the cony
They may be built into the systcm
connected with cables to CPU,

PROCESSING DEVICE

Central Processing Unit (CPU) is the processing device of computers, It is caii

the brain of the computer. It processes the inputs given to the computer. Ji 1

three main components.

e Control Unit (CU) : This unit works like a traffic policeman and manz;:
all the operations of a computer.

e Arithmetic and Logical Unit (ALU) : This unit is responsible for
performing various arithmetic operations like addition, subtraction
multiplication, division and relational and logical operations such as equal 1o,
greater than, less than, or not equal to, etc.

e Memory Unit (MU) : The memory unit stores information (instructions and
data), It is divided into Random Access Memory (RAM) and Read Only
Memory (ROM).

COMPUTER VIEMORY

A computer has a huge storage capacity. The storage capacity of a computer is
called its memory, It enables the computer to store data and instructions.
Computer memory is measured in terms of bits and bytes.

A bit is the smallest unit of information which a computer can process. A byte is
the combination of bits. It is the basic storage unit in the computer memory. One
byte means one character, A character can be an alphabet, number or a symbol

One byte consists of 8 bits.




| 1024 Bytes = 1 Kilobyte (KB) fﬁw Jou L_Lgo Tl

A computer can understand only two states—

1

| 4KB =1 Megabyte (MB) » ON (represented by 1) and OFF (represented
_ w MB =1 Gigabyte (GB) b)'; 0). Th.es'e two digits—0s and 1s are called

The memory of a computer is of two types :

1. Internal Memory or Primary Memory or Main Memory
2. External Memory or Secondary Memory

Internal Memory

Internal memory is also called primary memory or main memory. It is the built-
in memory designed to store data and instructions while the computer is working.
The data stored in internal memory is erased when the computer is turned off. It
i always easier to access data or programs from the internal memory as it is the
fastest of all forms of computer data storage. Internal memory is of two types :
RAM and ROM. =
RAM is Random Access Memory. It stores the information
temporarily and works like a blackboard which can be constantly
overwritten with new data. The information stored in the memory is
lost when you turn off the computer or the power goes off. Due to,
its temporary nature, it is also called as the volatile memory.
ROM is Read Only Memory. It holds the start up instructions that prepare a
computer for use. It also consists of programs that check the proper working of
all computer parts when you turn on a computer. The instructions stored in ROM
cannot be changed but can only be read. It retains the stored information even
when the power is switched off. Thus, it is permanent in nature and is also called
as the non-volatile memory.

For Your Iﬁgﬂ‘

When we start a computer, the operating system is loaded into RAM. Any software
: that we run is also loaded into RAM. It means that a computer with more RAM

N et s e G s s s 0 St S S i i B G P T W PO S S - - —

External Memory
memory where the data is stored on a long-term basis is called external
memory, Data is not lost in the external memory even when the computer 1S
d off. The external memory is essential because the internal storage of a
®omputer is less. It is also called the secondary memory.

It is stored at places other than the primary memory of a computer. For example,

H&l'd.'-:disk, CD, DVD, Blue-ray disk, Flash drive, Multimedia card, etc.




Hard Disk

It is the main storage medium for computers. A hard disk
drives stores information on a hard disk. It is fixed inside the
CPU box. It can hold a large amount of data. Hard disk is
made up of multiple disks which are further made up of hard
plattes of metal. Data is recorded on both sides of the disk. 4

Nowadays, hard disks can store up to 2 TB to 5 TB of data.

CD
CD stands for Compact Disk. It is a small, portable, ro,

medium disk with a reflective metal coating. It can hold tc;

phics, sound, images and videos. A standard CD has
diameter of 120 mm. It can store up to 700 MB of data. T
access data from a CD, we need to place it in the CD drive
which is fixed into the CPU of the computer.

DVD
DVD stands for Digital Versatile Disk or Digital Video Disk. It

is an optical storage device used for data storage and for
recording movies with high video and sound quality. DVD is [
similar to a CD in shape and size but can store a huge amount | o
of information. The storage capacity varies from 4.1 GB to 17
GB. A device called DVD-ROM is needed to use the DVD.

—{]

<+ Using CD/DVD
® Press the push button present on the CD/DVD Drive. The tray will slide out.

® Place a CD/DVD in it and press the push button. The tray will move in.
® |If the CD/DVD has Autorun program, the CD/DVD will start running

automatically.
® If the CD/DVD does not play automatically, double-click on the CD Drive icon in
Computer folder. It will display its contents. To open any file, just double-click

on it. —— IR

L

Blue-ray Disk
It is a new optical disk format which is rapidly replacing DVDs.

It can store up to 25 GB on its single side and 50 GB on its dual
side due to the blue violet laser technology it uses. It is mainly

Book-4




r to be fitted into the computer where it is being used.
Flash Drive
popularly known as the pendrive, it has replaced the floppy
drive and has emerged as the most popular data backup
device. It is used for copying and moving data from one
computer 0 another. It is a small, light weight, removable
and re-writeable drive. It is a plug and play device that
plugs into a computer’s USB port and is also

P

i

A

‘store high quality sound, games and movie data. It requires a Bluc-ray

known as USB flash drive. USB flash drive has large storage capacity, generally

in terms of giga bytes. It does not contain any internal moving p

small in size, easy to use and highly durable.

Multimedia Card

It is a portable storage device about the size of a postage stamp.
jt is used in mobile phones, digital cameras and music playcrs
for storing data. It can be easily removed and used for transfer
of data to the computer. The multimedia card is inserted into
the card reader and is connected to the computer through the
USB cable. Most of the laptops come with inbuilt card readers.

T
% Crossword Puzzle

Down & P
1. This is the main memory of a computer |

2. The data stored in this memory is
lost when the computer is turned off 3

arts, Thus, 1t 15

SanDisk Z

g
N
(==
=2
L #4 ]

With the help of the clues given below, solve this crossword puzzle.

v
=
g 4
fomd
o |
v
&
-
-
-
=
b
-

4, It holds the start up instructions IEi 4
B

5. Only two states 0 and 1 that a

Computer can understand are
4 Clled ............. digits. [4R
'*-s!-"i" a new optical disk format

A

3, ‘ ‘ i
This is the other name of Flash drive 5 -
I B




: ght opﬂom
hysical devices of a computer are called :

: ["] (b) hardware [1(c) data
vices that help us to enter data into the computer are called
fa) input devices |__i (b) processing devices ___i(c) output device:

' devices that give us the result of the work done on the computer are cal|

(a) processing devices [ (b) output devices [_1(c) input devices

= 2 ‘ I.-i. B s is not a secondary storage device.
fif (a) RAM [_i(b)DVD ___i(c) Flash Drive
5. 1KBisequal to
(a) 1000 bytes [ ] (b)1240 bytes [ 1(c) 1024 bytes

B. Fill in the blanks with the correct words.

1. The keyboard and mouse are ... devices.

2. The printer and moNitor are ... devices.

3. and are the two types of memories present in a computer
4. A Flash drive is popularly Known as ... -

B ilidicaniereoes is used as a popular security device.

B, A oriivsiciins is used to read the barcode given on a product.

7. DVD stands for ... ;

C. Answer the following questions.
1. What is an IPO cycle?

2. What is a graphic tablet?

lllllllllllllllllllllllllllllllllllllllllllll

3. What is the use of a scanner and a web camera?

lllllllllllllllllllll AR AAFRABRRNRRINRRER




differences between Dot-matrix printer and Inkjet printer.

‘....... A L e L LR L L bt bbbl

T T T bbb
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® Solve this crossword puzzle using the hints given below :

(X

>

sl

1. Large printouts of drawings are taken out on
Paper Using ..........c.ccevnenne .

B e cesiuvsiaginss does mathematical and logical

calculations in a computer.
C I R—— gives output on a paper.
TR is temporary in nature. B
Bt nsscnsniusanes is permanent in nature. ”
B et s esovnssos is used to start the operating

system in a computer.
o e e is a unit of the computer

memory.

Bprsniin

® In the school lab find out the different input and output devices available. Make a
~ list of these in a WordPad. (Go to Start—All Programs—Accessories— WordPad.)
‘one use of each input and output device listed and also draw its picture in

the computer lab and learn how to use CD, DVD, and Pen drive.

pmum of various storage devices from computer magazines, internet,
 make an informative chart on ‘Types of Storage Devices".

Book-4




+  Features of Windows 7 + Files and Folders

+ Desktop Background « Windows Explorer
< Screen Saver % Using Context Menu
- Setting Date and Time » Whatis a Shortcut?

In the previous class, you learnt about Windows as the most commonly usc:
operating system. Operating system is the most important program of -
computer. It is a medium through which we can interact with the hardwarc
using software. It controls all the activities of a computer. There are variou
types of operating systems such as Windows, Linux, Unix, etc.

As soon as the computer is switched ON, the operating system gets loaded onto
the computer’s memory. It remains.there till the power is on. In this chapter. you
will learn more about Windows 7 operating system.

FEATURES OF WINDOWS 7

Windows is a Graphical User Interface (GUI—pronounced as gooey) between @
computer and its user. The first version of Windows operating system was
Windows 95. Since then, many versions of Windows have been released. The
most popular versions of Windows are : Windows 98, Windows 2000, Windows
ME, Windows XP, Windows Vista, Windows 7 and Windows 8.

Windows 7 operating system has become very popular because of the following
features :




' Attractive in Look and Easy to Use

windows 7 has a very attractive look with colorful themes and slide shows. It is
very easy to use Windows 7. The use of graphics make it quite interactive, [t
works the way we want and makes new things possible.

searching Made Easier

Using Windows 7, we can quickly search for more things in more places in our
computer.

Windows 7 Taskbar

The taskbar of Windows 7 is more flexible and application oriented. We can pin
our favourite programms on the taskbar for casy access.

For Your In@o

The new Aero Peek feature allows us to turn the open windows
« transparent and make the Desktop of the computer visible.
! To do so, just point and click on right edge of the taskbar.

- D D

Windows Supports Multitasking

Windows 7 can perform more than one task at a time. For example, we can type
letters in MS Word while enjoying music using Windows Media Player.

Jump Lists

This is a new feature which takes us straight to the documents, pictures, songs or
websites you recently visited. To open a Jump List, right-click on a program
button on the Windows 7 taskbar. For example, the Jump List for Internet
Explorer shows the recently opened websites.

DESKTOP BACKGROUND

Desktop background is the background image that is used to decorate the
top . It is similar to the tablecloth with designs you use to decorate the table

iese designs can be taken from the list of options already available or can be
Created in Paint, You may also use photographs stored in the computer as a
-Sktop background.
"8 to change a desktop background
_Mght click on the desktop. Click on Personalize option in the shortcut ment.
Personalization window appears.

¢ on the Desktop Background option. The Choose

your desktop

“CKground window appears.




Desktop Background
Window

® Select the desired background from the given list.
" Double-click on the image or click on Save changes. You will return to thc
Personalization window. -

Click on the Close button and the chosen background will be seen on the |
desktop.

SCREEN SAVER

Screen saver is the image that you see when the computer is left idle for some |
time. The screen saver disappears as soon as you click the mouse or press any |

key.
You can select screen savers already stored in Windows or create new screen |
savers. The idle time after which the screen saver will be displayed can also be

changed.

Steps to use a screen saver

® Right click on the desktop.

Select Personalize option from the shortcut menu.

The Personalization window appears.

Click on the Screen Saver option. The Screen Saver Settings window
® Select the screen saver of your choice from the Screen Saver drop-down list.

® You can also specify the time after which the screen saver should appear it
the Wait: box and tick the On resume, display logon screen checkbox.

® Click OK or Apply.

LN
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Personalization Window Setting a Screen Saver Specifying Details
for Screen Saver

o Close the Personalization window by clicking the Close button.

f For Your Iﬂ-€0‘

You can also access the Personalization window by taking the
+ following path : Start —» Control Panel — Personalization option.

SETTING DATE AND TIVIE e
Every computer has a built-in calendar and

clock. It keeps on working even if the ;,m 5 m,::: :,
computer is shut down. It is displayed on the 8 SR
night end of the taskbar. You can change the 9101 12 131
time and the date by clicking on it on the f| X222 -
taskbar. Click on the Change date and time el i

settings .. option.

| 45 -

»

Date and Time on the Taskbar

The Date and Time dialog box appears. Here
you can change the date and time.

Date ang Time Dialog Dox

z
j
B
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For example, iy, ,,

ep important Papers |,
wd  the form of a file |,

e desired file. Every filc hys |,
| -7

Various Flle Names

Folders : Folders are used to classify files in a computer A ™
collection of related files can be grouped in a common folder.
You can name a folder just as a file is named. A folder can
contain files as well as other folders. The folders are also known
as directories. Usually, a folder is represented by the icon given

winoows ExPLORER B

Windows Explorer works as a
manager for the Windows. It |
manages and organises files and |
folders. Thus, it is also known as -
the File Manager. You can delete,
see, copy or move files and folders
with the help of Windows
Explorer. i

When you double-click on the
Computer icon on the desktop, you
will get the screen as shown in
adjoining figure.

Click start

Windows Explorer

- You can also open Windows Explorer by clicking on the
Windows Explorer icon given on the taskbar.
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S Word, it starts

ter completing your |& ek 8, SO

- save your file 3" i
Office Button >
stion and type a
ne in the Save As

of o=
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’ommon way to create a ﬁle 1s by using any apphcatlon software

INFORMATION TECHONOLOGY
KNOWLEDGE

INFORMATION
PROCESSING

BYSTEM
-

box. This creates

Folder
k once in the blank area of the

Ip menu appears.
> New option. A list of sub-

Creating a F:Ie

). Folder
@] Shonos

3 Micrasoft Office Acosss 2007 Detabase
! Fash AdSonSaript file

B CortDRAW X4 Grapiic

Contac

B Cored PHOTO PAINT X4 kmage

€2 Microsoft Offics Word Document
 Jounsl Doosment

) Pageialesr 7.0 Aublicaton

%] Macosoft Office PowerPaint Presendation

the Folder option. A new
be created and displayed on

v

View +| 4§ Adobe Photoshop g 13

Sart by /@) Miousoft Offics Publisher Docament
Refresh B WinRAR antive

Paste ) Test Docsment

Paste shortat Wj Cored Ventua 10.0 Adlication
Unda Rename QrZ |2 Adobe LveCyde Designer Doasment
Graghics Properties_ &1 MicrosoR Ofios Exoel Workshest
Graphics Opsions * | WAMRAR 2P archive

L —

Screen resoloion

ew folder is created.

ing a F or older

a, }z or folder means making a copy of the original file in another
without removing it from its original location.

-the desired file or folder in its respective location.

kwiﬂdows Explorer, click on Organize drop-down list - Copy option.

I




Moving a File or Folder to another Folder

® In the Windows Explorer, select the file |agn: . om
or folder to be moved. &3 Ao
® (Click on Organize drop-down list - | :-_”---{(:Lut
Cut option. G option |
® Select the destination folder from the mog |
navigation pane. |
® C(Click on Organize drop-down list — '
Paste option in the destination folder to - S S——
move the file or folder. b
) For gﬁur IN&T '!5‘

You can also move the cut file or
The drives and folders you go through to

? folder into a new folder.

e e e
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Usmg New Folde-r Option

k on New folder in the Menu Bar. “

e folder and then select Paste g click.on the desied e o |
Organize drop-down list. mdsdzetﬂfmn mmm

ng a File or a folder

| e file or folder.

Right click on the mouse.

ect Rename from the shortcut menu.

e of the selected file or folder will
ighted with the pointer blinking
ide the name box. Write the new name.
ess Enter key or click outside the file or the folder.

ting a File or a Folder

elete a file or folder follow the steps given below :

: right pane of the Window Explorer, select the file or folder to be

ICIEIeC

'

Aick Organize drop-down list = Delete option. The Delete Folder dialog
X appears. Click Yes to confirm deletion.

5 OR
e '&sln-click on the folder required to be deleted.
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Pt St e e ey Browimd b ;
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= T O e T [ Delete
—— = = P opti
o - Det.ete .,:,‘ ———— " P on |
e > | option -
Mo Vsl X . Sttt e endmA LR LL M AM :o—-—
e R - 4 by R

a. Using Organize Drop-down List b. Using Shortcut Menu
| Deleting a File or a Folder

| L ® Seclect Delete from the shortcut menu.

® The Delete Folder dialog box appears.
Click Yes to confirm deletion.

For Your Ingo

When you delete a folder or file, by
,  default Windows moves it to the
. Recycle Bin. The file/folder remains
. in the Recycle Bin unless it is

___deleted permanently. i

L Press the
J. Click Yes in th-
rm deletion

|ft+ Delete

o

USING CONTEXT VIENU

When you right-click on any icon, a pop-up menu appears which is callc
Context menu. Using this pop-up menu, you can save your time to acces
commands. Right-clicking on different areas and objects will display differen

sets of commands. The Context menu is also called the View .
Shortcut menu. Sort by y
Refresh

Right-clicking on the Blank Area of the Desktop Paste

When you right-click on the blank area of the E‘;‘:m —_—
desktop you will see a menu with different options S ———— |
and Personalize option at the bottom. Using the Graphics Options .l
Personalize option, you can change the background, New J'
settings of the desktop, screen saver, appearance of  |Bg saven resolution |
icons, menus, message box, font, color, etc. and can  |® Gadgets |

l‘ ; also give various visual effects to them. & Posonalize -
Right-clicking on the Blank Are:




ging on the Object *
ju right-click on any icon on the desktop, You — cu-
nd an entirely different menu. The Properties % r..,.
will be found there at the bottom of the list. a Mg net e
“: (hrscrmaws? ruvne s Arven
” (::::ﬁmn
Rerarme
‘.'""-: Progmertos;
3 ey
e TIS A SHORTCUT? Right-clicking on the lcon

ortcut £ is an icon that provides an easy and quick way to open any
cation or software that we use frequently. The lower left corner of the
t icon has a small jump arrow. Double-clicking on the shortcut icon will
e file or program it represents. .

Ci@ng a Shortcut Icon for Microsoft Word

o ( on the Start button@ and select All Programs. Place the cursor on
Microsoft Office Word 2007 from the Microsoft Office folder.

ht-click on the Microsoft Office Word 2007 program. A pop-up menu
appears. Select Send to option. You will find another cascading menu. Now,
click on Desktop (create shortcut) option.
® A shortcut of Microsoft
Word fZ appears on the
des with a jump
arrow in the lower left
corner.
® Double-click on the

shortcut icon to open - - Y. oopnomtipet i
the application directly. |3 Do

Creating Shortcut on the desktop

ﬂ.—-&




[_1(c) WordPad

L_i(c)word
evant files stored together on some storage device:
D.:(b) folder [__I(c) desktop
e that is used to open a program.
__|(b) alphabet L_i(c) picture -
5. Where are deleted files or folder kept on the desktop?
= (a)My Computer [__|(b) Recycle Bin [_1(c) My Documents [

| ' B. Fillin the blanks with the correct words.

1 e is a medium through which we can interact with the hardwareq‘

using software. _ |
2. A s is @ collection of related information.
3. The folders are also Known as ...cuume: ;
4. A o is an icon that provides an easy and quick way to open an

application or software. .
5. Ashortcuticon has a small ... on its lower left corner. }

R—

C. Answer the f;:llowlng questions.
1. Explain any two features of Windows 7. i

' X

9

2. What is the difference between a file and a folder?

4. What s a shortcut? D)

5. What is the difference between copying a file and moving a file?
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Rewrite the jumbled words.

L swowno HIHEENEEE

2 eavek I HEENEEEE
3 rkase HHEHEEE

s pstroeck H HEHEENE
s.xperecon B EENEN

Double-click on the Computer icon on the desktop. It will display the drives and
folders. |

Double-click on D: drive. It will display all the files and folders stored in it.

Now, create a new folder in it and rename It with the name ‘My Activity’. Create 3
file in MS Word and save it in the ‘My Activity’ folder.

Right-click on the ‘My Activity’ folder and select Send to option from e
Shortcut menu. Now, select Desktop (Create Shortcut) option.
You will get the shortcut of ‘My Activity’ folder on the desktop.




# Project Board ,*

i & Collect the pictures and information of all the versions of Windows and prc..,. .

i 2 chart on various versions of Windows with brief information about therm

| Windows 8 Updates

1. Windows 8 operating system was released on 26 October, 2012, It ha
designed to be used on both tablets and PCs.

2. In Windows 8, the Windows Explorer screen has the Ribbon similar to tr.:
MS Word 2007 and Paint. You can manage files and folders with the help o
Ribbon. You can easily add folders to a library. Many options such as Cog

Move, Rename, Create new folders, Delete, etc. are available in the Home -
of the Ribbon.

Meme  Fhare  View

® - - & + Computes » Local Disk (C) » Usen » Patalong » v € SewosSesleng F

"‘; L's W Fovowha i Date modiied Type e
’ i, Cariep & Contacts 01/09/2012 12:84 File foides
& Downived i Dasiiop 01/0%/2012 1345  Fede foider
3 Recent pleces & Downlosds 010920121320 Fibe folder
&t Favourites 01/09/2017 12:44  File folder
ex L B unks 01/05/2012 12:44  File fokder
2 Documents k! My Documents 010920121312 File fokder
& Masic B My Music 01/03/2012 12:44  File folder
= Pactures & My Pictures 01/05/2012 1248 Fiba icider
B videos R My Videos 01/09/2012 12:44 Fbe Tokdes
i Soved Games 01/09/2012 12.44 Fibe folder

01/09/2002 1312

1. Play a movie or a song in Windows Media Player and explain the different features of the software
to the students.

2. Ask the students to independently create short documents in WordPad and Notepad.
3. Askthe students to create their own wallpapers and then apply them on their desktop.




+ Openingd New Drawing Canvas
« shapes Tool < Grass Effect < Waves Effect
+ Eraser Tool < Rainbow and < Wavelets Effect
+ Drip Magic Real Rainbow Effect % Printing the Pictures
o Edges Effect “+ Noise Effect in Tux Paint
se the basic tools in Tux Paint to /

Eﬁi_l_d;en! We have already learnt how to u
create drawings. We
along with various brush shapes,
also tried our hands at some mag
earnt how to save our work as well as ope
In this lesson, we will learn the advanced fe

+ Foam Effect <+ Smudge Effect

have learnt how to use the Paint (Freehand Drawing) tool
Lines tool to draw beautiful patterns and have
ical effects using the Magic tool. We have also
n an already saved file.

atures of Tux Paint with which we

can further enhance our drawings.
OPENING A NEW DRAWING CANVAS

We cannot work in a single file forev
different drawings. Once we save our previous work, we can ope

using the New tool from the toolbox.

Tux Paint offers not only a black, white canvas
with different colors in the background, black-an

er. We always make different files for
n a new file

for drawing but also canvasses
d-white outlines and with 3-D

photographs.
Follow these steps to open a new drawing canvas in Tux Paint :

Click on New tool in the toolbox.
You will get Color boxes and Starters to start a new drawing.

Click on the Down Arrow button.
ielect any color or any of the frame. Click on Open button. Let us try our
Aand and select the green color box.
fler you click on Open button, you will find a blank screen with a green
= wing area.
y(‘)’l‘:’ns:ou can draw anything in the drawing area. Since your canvas is gree,
ust use light colors like white, yellow or pink.

y
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. \‘0""’“‘ a New DEanwing L anvas o | ftedd

Sudge et

L shapes 1o oA et Waves | 1ot

L grasel Towl S Ratnbow and Wavelets | et

© pvip Magk Real Raimbow (et S PHnting the Pletures
o fedges bitect 0 Nolve et In Tux Paint

Childeen! We have alveady learnt how to use the basic tools in Tux Paint o |
create drawings. We have learnt how to use the Paint (Frechand Drawing) tool
along with various brush shapes, Lines tool to draw beautiful patterns and have
also tried our hands at some magical eftects using the Magic tool. We have also
learnt how to save our work as well as open an already saved file.

In this lesson, we will learn the advanced features of Tux Paint with which we
can further enhance our drawings,

OPENING A NEW DRAWING CANVAS

We cannot work in a single file forever. We always make different files for
different drawings. Once we save our previous work, we can open a new file
using the New tool from the toolbox,

Tux Paint ofters not only a black, white canvas for drawing but also canvasses

with different colors in the background, black-and-white outlines and with 3-D
photographs.

Follow these steps to open a new drawing canvas in Tux Paint :
* Click on New tool in the toolbox.

You will get Color boxes and Starters to start a new drawing.
Click on the Down Arrow button.

Select any color or any of the frame. Click on Open button. Let us try our
hand and select the green color box.

A“*{)’ou click on Open button, you will find a blank screen with a green
faWIng area,

y::: You can draw anything in the drawing area. Since your canvas is green,
Must use light colors like white, yellow or pink.

|
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Choosing a Background Color and a Frame for a New File

® Let us try our hand and create some new files with different backgroun
. colors.

. For Your Tnflo

Tux Paint is translated in more than 85 languages. Many I[ndians have participate:
actively in the translation process of Tux Paint into the languages of Indian origin.

. Ravishankar Ayyakkannu - Tamil Ankit Malik - Hindi
. Kartik Mistry - Gujarati Pavithran Shakamusi - Telugu
SHAPES TOOL .

Shapes tool is used to draw various filled and unfilled polygonal shapes. Th

unique feature of this tool is Rotation. We can also rotate the shapes by an
angle on a 360° scale.

Let us learn how to draw various shap
various angles.

® Select the Shapes tool from the toolbox. » DEEEE—
® Select Square from the sub-toolbox on A=

es using this tool. Let us draw a square ¢

the right hand side, Ea .
. ® You can either choose a Blank Square
s or a Filled Square.

® Bring the mouse pointer to the drawing
area.

® Select a point on the drawing area which
will act as the centre of the square.

< TRz

Pl & 1hapn. (Bt 1 purt Bha condien, @hng, un . whan 4 e yo want. e
Armund \n sotate &, aned R\ o - P

Drawing Squares Using Shapes Tool
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given by the Penguin.

Now you can sc¢ a spun arrow on the
drawing area which is used to spin the
image at any angle from the centre
point. Try spinning the arrow in any
direction to spin the Square.

Once you are done, click in the drawing
area to see the final image.

Let us draw four different Square

shapes at various angles. Likewise, try
your hand with other shapes as well.

Now click and drag the mouse. Choose the desired sizc and release the Jeft
button when you have completed the squarc. Read the instructions

e o RSB ~ B W -

o s chate § el WD W S

Drawing Various Shapes Using Shapes Tool

There are 16 different shapes available in the sub-toolbox of the Shapes tool.
— ERASER TOOL _

PN

Using Eraser Tool

DRIP VIAGIC

What happens when you sprinkle drops of
water on a drawing made with a sketch pen
or a letter which is written using ink pen?
The ink/colors will scatter and drip away
like water. Similarly, this magic sub-tool

gives a dripping effect to our drawing.

= = \ ' ® The Eraser tool is used to erase
—f -« | unwanted parts of the picture. It is very
- easy to use.

Q smabex ® Select the Eraser tool from the toolbox.
Eraser Tool f“ ® Select the desired shape of Eraser from

=4 :‘: 2 the sub-toolbox.
= TR § ¢+ | ® Bring the mouse pointer in the drawing
"'""’ﬂm'ﬁ”ﬁi'- area. Click the left mouse button and
drag the eraser to the area which you

want to remove.




.' (‘ilmk on the Shapes tool and
select any filled shape from the
sub-tool box.

& Select the Magic tool and choose
Edges from the sub-toolbox.

® Using your magic wand, click and
drag it over the entire picture. You
will observe that the edges of the
shape start appearing.

® Let us apply this effect to one of |
the stamps and observe the |
changes. Using the Edges Effect ]

roam erFecT @

You must have seen your mother (g

washing your clothes. Whenever she

adds washing powder to the water,

you see a lot of foam. In the same

way, this tool adds the Foam effect

vl you want,

AR

cih

M
Y

¥
B

iy

3‘% TR alglme
= W gi?guula -y

[ g b bam

L'.

Using the Foam Effect

Book-4




o WW you can simply use the Grass effect from the sub-toolbox to draw
at and tidy grass.

b pe you remember the various paint brush shapes that we have studied in the

» Select the Paint t_ool. Choose blue color and draw the river as shown in the
figure. On your right hand side, scroll down till the end and select the Vine
shape from the sub-toolbox.

-ﬂfﬂ ?

g Effect

"'.,\zr

;J Fi""
. \'{fne =3
- Effect '
¢ Ag -ﬁ ,, <™
Ny --!--r»—"-’th-:-—-v4

ors g’ = _‘
“l_“.““.-‘

Using the Grass Effect | Using the Vine Effect

® Draw the upper part of a tree using Vine tool at the right of your screen. To
make it more beautiful you can select a few colors and keep clicking to give a

better look as shown in the figure.
® Now select Magic tool and select the Grass effect. Draw some grass at the

river bed side as shown here.

® Select the Flower tool and draw flowers with different colors.

® Now select the Foam effect and draw some foam over the grass in some
places.

® Now select the Paint tool from the sub-toolbox, choose the Starfish shape.

@ g‘elect Brown color from the Colors palette and draw a few starfish on the

oam.
° smlaxly, you can use many brush shapes and magic effects to draw beautiful




raineow ) AND REAL RAINBOW @ errect

Rainbow effect draws a train of rainbow colors as you drag the magic wa;,| . |
the drawing area.

Real Rainbow allows you to draw a rainbow that we see in the sky after a raing, |

Let us try both the effects. f
e Select Magic tool from the toolbox and the Rainbow effect from the <
toolbox.

e Now place your magic wand anywhere in the drawing area and drag )
some other point. You will see a train of rainbow colors as you drag. Click
Undo button.

® Now select the Real Rainbow effect.

@ Choose a single point on the drawing area. From that point, click and dr |
the mouse to a new location.

® You will see a rough sketch of the rainbow as you drag your mouse.
® As you reach the end point and release the left mouse button, you will see

daha 1T

Rainbow Efect 4

. I"l'- - s
w! | Real Rainbow Effect) *~

a e

 Click where you want your rainbow to start, drag to where you want & to end, and then let go

pf) to draw 3 rainbow.
\
Using the Rainbow and Real Rainbow Effect "
For Your 1 ¢
+’I1]ousands of schools and universities have volunteered their services and ¢
» ' joined the online community of Tux Paint to improve and promote it. S

|
|
|

| 4 Tux Paint will soon launch a new range of Magic Effects named Blind, Hexag'

Mosaic, Irregular Mosaic; Perspective, Puzzle, Roygbiv, Zoom and many ish

o o Y S -
e . 0 g e U = S e e e

F



SE EFFECT

sct 18 used to add white noise
drawing. Sometimes while
g television, the TV signal
uddenly disappears. At that time, you
see thousands of black and grey dots
on your screen with some noise. That
is called the Black noise. White noise
is a mixture of grey, blue, maroon and [ " O " % A
white dots. A

Using the Noise Effect

SMIUDGE EFFECT !

Smudge effect is used when we draw
water bodies in our drawing. It is used
to mix two different objects smoothly.
® Let us draw a blue ball and a yellow
ball close to each other. Assume that
we have drawn them using wet
paint.
® Now use the Smudge effect to show
how the balls will look if we join
them from one end and form a new

Using the Smudge Effect color.

f For Your IM&J‘

Tux Paint supports vector graphics which means that you can

¥ draw images that can be zoomed up to 100 times their original
i size wlthout compromlslng on the quality of the image

- - - - - - - - - - - '\

WAVES EFFECT .

:tg‘:cteﬁ'ect 1s used to wiggle any picture side to side (Horizontal). Let us use this

.
" Open a new file with Blue background.

? ﬁglu%t the Paint tool and draw a filled curved structure as shown in the
Tigure,




- R - -

® Now select Magic tool and then sclect
the Waves effect from the sub-toolbox.

® Read the instructions given by the
penguin carefully.

® Now click on the screen to get the
desired Waves effect.

® Let us click at the bottom of the screen
for taller waves.

waveLETs erFecT B | Using the Waves Effect

and down (Vertical) rather than side to side.
Let us apply this effect to our picture.

® Undo the changes on your picture using the
Undo button from the toolbox.

® Click on the Wavelets effect. Read the
instructions given by the penguin. 4
® Click on the top of the drawing area to add [ Jammmeu'
shorter waves to your drawing.
Great!! Now save your work. DEGHIE Shoster Waves
PRINTING THE PICTURES IN TUX PAINT e

The pictures created in Tux paint can also be printed. Follow these steps to pr
e T i - #

a picture : o = - Yo
I. Click on the Print tool in the Toolbar [£\C g _ E \‘3‘-
pane. " 2 me
2. A dialog box appears asking for your = z
permission to print the opened picture. 8
Click on Yes, print it! option. p B
3. The Print dialog box appears. Select ?f‘
the printer connected to your computer "
in the Select Printer section and [
specify your printing preferences. _

4. Click on the Print button. | Using Print Tool

You have learnt almost everything about the Tux Paint, its various tools "

their sub-tools as well. Draw more pictures with new effects and ideas for b<'*
understanding of the tools.



the right option.
g SN different shapes available in the sub-toolbox of the Shapes tool,
| L_lb)18 L) 20 ] |
m create a dripping effect of wet paints using the ........... effect of Magic tool.
Drip L1(b) Smudge L_1(c) Foam L]
can rotate the shapeup to ............. degrees.
80 L_1(b) 260 L 1(c) 360 L
- effect adds horizontal wavy effects in our picture.
‘aves ol (b] Wavelets i (C] Tornado =
'the blanks with the correct words.

w1001 is used to create and open a new file in Tux Paint.

W various ..... X and

.. Magic effect is used to trace edges from the already drawn image.

- €ffect draws a train of rainbow colors as you drag the mouse
wing area.

polygonal of shapes using the

. effect is used to mix two different objects smoothly.

owing questions.
he different features of Tux Paint associated with the Open tool?

use of Shapes tool?

e use of Drip Magic effect?

.......................... |
SLLEL TN T TR T e T T TR T L R R AL LA L LA L AL AARRARRERY ARARTARRARA AR

y two commonly used options present in Print dialog box.
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' Match the following.

(a) Grass effect

(b) Foam effect

(c) Opensanew drawing canvas

(d) Magic tool

WOCT o el N N N N IR

i

g B ) |




.~ Changing the FontType < Highlighting Text = Creating Bulleted or
& Changing the Font Size < Changing Text Alignment Numbered List E
+ Changing the Font Style <+ Changing Color of Text < Applying Border and Shading
+ Changing the Font Color <+ Changing Line Spacing <+ Applying Drop Ccp
/

Formatting means changing the appearance of a document to make it attractive.

We can create and design appealing documents by changing font and its size. ‘
highlighting certain words, adjusting line spacing, setting margins, setting tabs.

aligning text on a page, creating bulleted or numbered lists and changing text

styles and color.

Formatting effects can be applied using the Home tab, which contains : font
formatting commands (Font group), paragraph options (Paragraph group) and E3

text styles commands (Styles group). *

CHANGING THE FONT TYPE

A font is a set of letters and symbols in a
particular design and size. Each font has a
name. Some of the examples of fonts are listed

here. For Your IH.&T

There are also fonts such as
aomcioe a8 A v wingdings that contain pictures

Cruiomey gl o D Sk
S i

.~ called d_in_gbats.

-

Select a part of the text. Click the Font 53
name drop-down list and bring the mouse
pointer on a font name to preview the
selected text in that font. Do the same
with other fonts and at the end, click on

nts
A Few Examples of Fo the desired font name.

Book-4




CHANGING THE FONT SIZE
The size of the text is called g oS
the font size. It is measured in | Ae=ses o bl 8 ER S0 S0 dwos: B o
points. There are 72 points in  [™5" o &5 :

an inch. A few examples are
given here.

This Is font size 12,

This is font size 20.
This is font size 24.

This is font size 28.

CHANGING THE FONT STYLE S

S
The way in which a character is emphasised is called its font style. The mc g
common styles are bold, italic and underline. | &

Bold | B
Bold text is printed darker than normal text so
that words and phrases stand out on a page. It
is often used for titles and headings.

Italic Z! C

Italic text is slanted. It is mostly used for emphasis. It is sometimes used ! It
headings and also for representing scientific names. ot

Underline @

Underlined text has a line under it. In the Font dialog box, you can selec! L
Underline style: from the drop-down list. From the Underline color: drop-d°"
list, you can select the line color. It is also used to emphasise the text I Y
sometimes used for the title of a publication. dc
You can also choose More Underlines... option from Underline drop-do“" "gi
A Font dialog box opens from where more styles for underlining the tex! il @
chosen. Normal text is the default style for a document.
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Selecting the Underline Option

Superscript -
Superscript reduces the size of the text and raises it to the top of the current line.
For example, today is the 5" of January. Here, the ‘th’ after the digit 5 is a

superscript.

Subscript .
Subscript is a text style that reduces the size of the [aAppiv

text and lowers it to the bottom of the current line.
or example, the chemical formula of water 1s
H,0. Here the base 2’ is a subscript.

CHANGING THE FONT COLOR
It is used to change the color of the text to emphasise headings, subheadings and

other text.

b s
ticky Note

Bright colors and many colors in a single document are not usually recommended.
- GHTING TEXT

You can highlight the text in a word
ne to mark some important facts i

given below,
Click on the Text Highlight Color drop-down list in the Font group of the

Home tab. You may also choose different colors for highlighting.

document with different colors. It is usually
n the text. The steps to highlight the text are




Mm*ethcpenmcr
the textthat hasto be
highlightad

®  To remove the
t2xt, select No Color

S ln—ﬂyu-b—tmrwmhmnum:‘
option from Text Sers © gt P Yt e Fver tewcm

Highlight Color | |
drop-down list _———————_

Hghiighting Text with a Di¥ferent Cosor

CHANGING TEXT ALIGNIVIENT

Alignment refers to the positioning of text on a = R S
page. We should set the alignment before we = =" —IEEFaT
begin typing We can also select an entire EE_EEE = -
document and then change the alignment of text.

MS Word provides four types of alignment : Align sl Saition~
Left, Center, Align Right and Justify.

 Align Text Left : It places all the sclected text to the lefi 1 margin. B: |
default, the text 1s always aligned to the left margin. e :
b: §

- - Center Align : Sets the text in the center of the left and ng
- ——  margins. It is mostly used for titlesheadings.

i Aﬁ;:kxt Right : Aligns all the selected text to the noht margin. | !
— _ is often used for placing dates or reference in a dm.ument. |

T
A e e e e i

 Justify Align : It places the text evenly bet\\een the left and ngt
: E |margms It 1s mainly used for designing books, magazines i
| | newspapers.

}i

e e L —

How To Align ?

& Select the text. Click on the desired alignment button in the Parac’™
group.

® Observe the change in the alignment.
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an also change the type of FPooess ossmamen oy o

PRl By ey P

£ by clicking on the Page D4 S musiwbiair” & »

.' AL A L = l.: e ..
__ | e et : _
on the Paragraph (|la|0g box F*——"-->---ov— —

Select the text. Click on the| desired alignment
| button in the Paragraph group.

by clicking the drop-down arrow next
1o Alignment option under ‘General’
section.

Observe the change in the alignment.

I
‘. We can also change the type of alignment by
: clicking on the Page Layout tab.

I Applying Alignment
cHANGING COLOR OF TEXT
MS Word provides an option to e
change the color of text. e
o Select the text and click the |, 9 # Afeiasl &5 mie | 55
Home tab. =
® Click the drop-down arrow

L CmiBem - E-ECERE »
3 I" IO x| EEE T IS é: %
“ 2z

M0 7 | Theme Cetes T T e vy |
. P T T 111 1| my o S == -
o= . P-‘Elﬂ‘m P e B T T e TR

I__ﬂ!!i ih Changing Color I
?

next to Font Color on the |

Home tab. Select the desired | | | e
color from the displayed |

Font color menu.

CHANGING LINE SPACING Changing Color of Text

Line spacing is the vertical distance between successive lines of the text in a
document. We can also increase or decrease the line spacing between a

paragraph, S
® Select the text. ——

® Click on the Line spacing button in the [ oe== B

- Paragraph group on the Home tab. — o =

1

Q'_lr Select the desired option of line spacing from the
! drop-down list. Or

i To set more precise spacing measurements, click
: ';he Paragraph dialog box launcher. Select the
i nde.“t and Spacing tab and then select -the
;grcq‘f'red Line Spacing option under Spacing
il e

.. Click on OK button and notice the change.




y typed word.

:t on the text, click on Numberin, buttg
ct the list style of your choice,

-

on the Bullets button in
the Paragraph group
on Home tab.

® Select the bullet style
of your choice.

® You will find that the
text is bulleted and the

. . ‘ Mun-u;rm_
indents are automatically |- Select the tex{% *mreorn A :

, adjusted to separate the Home tab, e
text from the bullets. .

Select the bullet style of your cholce,
*  You will find that the text js bulleteqd and the indentd

' :F--.-‘__:‘

ottt wowser p

s Creating Bulleted or N :
For Your IM&T Umbered Ljst
lab stops are used to describe the location at which the curs
0
. r the Tab key has been pressed. Tab stops are common|y I Stops after
. i

us _
users to align text easily by pressing the Tah key. By defauyit Edh t(; enable
' setatevery0.5inch. We can set the Tal stops by clicking o .he l‘ulse?ps are

APPLYING BORDER AND SHADING e A
To improve the appearance and readability of the text, we can adq 3 Variety of
L border and shading effects to paragraphs and entire page.
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snd 13T~ |~ shading (@ F——H
e I = L =
| i .
— - o] o e
cting Borders and Shading Option Border and Shading Dialog Box

t the text, click on the drop-down arrow next to the Border button in
Jaragraph group on the Home tab. Select Borders and Shading option.

k on the Box option under the Setting section. Select the line style using
scroll bar under Style section.

ck on the drop-down list of Color and select any color.
ose the line width from the Width section.

® Click on the drop-down list of Apply to section and select the Paragraph
-
ick on OK and observe the change.

~ PLYING DROP CAP

In order to give a graceful look to your document, apply Drop Cap effect to the

first letter of the paragraph.

® Select the letter. Click on the Insert tab and select the Drop Cap button in
the Text group. e e o

® Define the parameters in Drop [¢ — Ao S
Cap Options (if necessary). | _se s e SRS
Click on OK button. ol - . -

. L |
’ Obscrve the change. lick on the Box option under| =
Select the line style using thescrowu
Style section.

e T

Using Drop Cap Effect |

‘ y Book-4
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1l you '_change the font in your document?

.'!!F""“ "o LLLELT] B T PP TTLTH

” I ‘
erstand bY text allgnment" Name the types of all"“

T PO T T T,

e Y T I ] Staarrnnnnnan ALLETY

do wn nnderstand by llne spacmg';

=t R L LU LT LT T Ty LLLEL R YR

5. How do you start a bulleted llst as you type?




fonitoy

ind the words from the given word grid and mark them with coloured pencil.

L'_ITNJiE;#S‘P*A'C_I N| G

Formatting Flo|R[M[A|[T T 1 NG A

Alignment A‘:B'UI\LiLiE'_T-rS:C:b_L

Line Spacing | clalp{e|Fle|L|c|B|D]|]

Italic E[s|1|A|F|O|N|F|S|T|G]

s | [ali[TaL e s c o

Fonts Bl{J|u|s|[T|I|F|Y|D|C|M]

. Justify Blp|E|G|H|Cc|B|O[L[D E

\ Bullets R M!|B o- DZD'MiNTx M_N_‘

\ ; cim{LlolP|ald|T[AlY]T]

N Els|1|A|F|1 s}o;N—S T

! ® \Write an article on the different types of alignments possible in MS Word 2007.
| Use Borders and Shading effects to explain about each alignment.
¥ Project Board *

“ InMS Word 2010 : _
» There is an option to add digital signature to a document, or you can insert a

Microsoft Office Signature Line. This allows us to have paperles;; signing
processes for documents like contracts or other agreements. These signatures
can also be compared with the original signatures and thus verified.

» There are new fixed-digit numbering formats, such as 001, 002, 003 ... so on,

and 0001. , :
»  There is an option to quickly add a check box to forms or lists.

2 0On Teacher's Desk

L Share a document on ‘My School’ with the students and ask each one of them to format it based

on their knowledge and understanding of formatting text in MS Word 2007. The students can be
asked to share their formatted document with other classmates and explain the features used.
Divide the students into groups of five. Conduct a quiz based on the concepts learnt in this

Chapte.
i 47 i
‘ Book-4 ‘
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& Starting MSWLOGO Other LOGO Commanas
i - D IR L - Da“‘ng Shnpes .||'"| :__")GO

Recaling Bementary LOGO Commanas

) is a simple computer languagc

LOGO (Language of Graphics Oriented ple ¢ _ .
like drawing figures. typing text .

kids. We can perform various functions
performing calculations using LOGO.
To perform any action, LOGO uses a triangle-shaped turtle that moves on !
computer screen. It is just like our pen. We use commands to move a o
around the screen and can draw different figures. These commands are kno .
as Primitives.
STARTING MISWLOGO
& For Uour I 01.60‘
F The steps to open MSWLogo are :
o ® Click on the Start button and

If LOGO is not already on your comput:
* you can get it for free from

choose All Programs. Calie”
) ) ~ www.softronix.com www.mswlogo.htms
e Select and click on Microsoft | ' '
Windows LOGO. 5 vewtog B
" . Fle Gmap Set Zoom Help M T
The following MSWLOGO screen | MenuBac
appears. l Title Bar
Turtle’s | = ===
Playground | : ———Turtle J

. [ Eeailst }—= v Fagse Stus e (.:On\_ﬂi.\ W
Box | | Wt 3 Sweo Reset Window
I__ + Ve raa '
T = "
Input Box: L ‘gomma :
‘ 3 Nl \ Buttons §
e To exit Logo, type BYE in the Command Input box and click on Execute butto” §




EMENTARY LOGO COMIMA NS

: Dttt " f
8 few Primitives in the previous class

3

, Let's review

D primitive moves the turtle forward by a given

Forward number of steps, 1.g,, Type FD 40. Jin Command
Input box,
BK primitive moves the turtle ha.ckw;:"r‘(-lrh_y a given
Backward [lumhcl;r of steps. E.g., Type BK 40 ._Jin Command
Input box,
IIJ; primitive turns the head of the turtle towards the
eft side.
Left
E.g., LT 90._Jwill turn the head of turtle 90 degrees
towards left,
RT primitive turns the head of the turtle towards the
Right right side. '
E.g., RT 45 __will turn the head of turtle 45 degrees
towards right. :
H The HOME command brings the turtle to the centre
pne of the screen. E.g., HOME _|
, HT primitive orders the turtle to disappear from the
Hide Turtle | green, E.g., HT.
ST primitive orders the turtle to re-appear on the
Show Turtle | ¢creen E.g., ST.
CS primitive clears the entire picture drawn in the
Clear Screen | graphic field and brings the turtle to the centre of the
screen. E.g.,CS .
CT primitive is used to clear the contents of the text
Clear Text | ¢creen. E.g.,CT __J
This command orders the turtle to lift the pen up from
Pen Up the screen and move without drawing any line. E.g.,
PU _J
This primitivc orders the turtle to put the pen down
Pen Down | . (he screen and start drawing. E.g., PD.__ .
NI ’ 4 < gv " rubs
By PE primitive turtle’s _pcn'acts like an eraser.
Pen Erase ognhc 'ﬁmwing over which it moves. Eg, PE |




=T

" This md sets the thicknm oﬁm pen. It
sary to type the number twice in the

wmand with space in between,
Command : SETPENSIZE [5 5]

Example : FD 100 SETPENSIZE [5 5] RT 90 FD 100
SETPENCOLOR
When we give this command the turtle changes the color of the pen with U

color code specified by us.

Command : SETPENCOLOR N Enter (N is the color code)
The available color codes are :

| black 8 :

r

salmon §

0 4 red brown 12

1 blue 5 magenta 9 tan 13 violet |

2 perea 6 |ycllow 10 forest 14 | orany

3 cyan 7 white 11 aqua | grey
Example : SETPENSIZE [55] FD 100 RT 90 [Hs=s

SETPENCOLOR 4 FD 100 RT 90 SETPENCOLOR 8
FD 100 RT 90 SETP[‘NCOLOR 14 FD 100

SETSCREENCOLOR

This command sets the color of the drawing '}
in a specified color. We give the color code aflc
the command.

SETSCREENCOLOR 6




A

For Uour 1 H.Ko

4 ,
R | ' ' REPEAT command is used to repeat some steps in a program.

. e e LT | e

‘the following commands and see the output. Write the name of the

e thus formed. ........
‘ __REPEAT 360 [FD1RT1) J

OODCOLOR and FILL ®

<e this command to color a drawing (enclosed "If the lines are not joined
TFLOODCOLOR command sets the color to (ot SR A

and FILL command fills the drawing area only s fllac Wik Eoer

Je is facing inside the drawing. To do this, we

move the turtle inside the shape by using

RT and FD commands.

ad : SETFLOODCOLOR N FILL (N is for the color

» Let’s see how to draw and fill color in a square.
4 [FD 80 RT 90] PENUP RT 45 FD 20 SETFLOODCOLOR 2 FILL

AEIMQUYCBGST_r
KOPENUPSAWEA_
¥ ple|e|J|m[P[s|V]|CIH|TIY
4 PENERASEKOPC
BHDKNQTZ_\L\LMEL
= olFlo[r|W[A[R[D|A|EINIF
‘ﬁ Rlu{w|A|D|G|J|M|R|PIC}T

vIisin|v|c|x|o|s|o|w|olA

=T Imlaluly[BlE[H|ILIT

sTe(T|P|E|N|S|![2]EIO|B
. et w7 ale T L PIR]T -




ce square, hexagon and circle, -
= Number of sides

a _ ' triangle 3 120 | REPEAT 3 [FD 50 RT 120}
E square 4 90 REPEAT 4 [FD S0 RT 90] |
D pentagon 5 72 REPEAT 5 [FD 50 RT 72]
J: J hexagon 6 60 REPEAT 6 [FD 50 RT 60]
8 ) septagon 7 51 REPEAT 7 [FD 50 RT 51] |

g _) octagon 8 45 REPEAT 8 [FD 50 RT 45]

o ) nonagon 9 40 REPEAT 9 [FD 50 RT 40]
[ " ) decagon 10 36 REPEAT 10 [FD 50 RT 36 |

The value of FD can be changed as desired. To draw a
circle, we have to make the turtle move 1 step forward and
1 degree to the right 360 times.

Command : REPEAT 360 [FD 1 RT 1]

To draw an arc, we need to reduce the value of the angle.

Command : REPEAT 240 [FD 1 RT 1]

We can change the size of the arc by changing the value of

the angle.

{52}
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‘: pfour @rain

) the right option.
k... command picks up the turtle pen.

7 ‘”",.J’
E_

[_{(b) PE | (9 PD -
__makes the turtle’s pen act as an eraser. 2
Li(b) PU L_i(c)PE -

... sets the color of the drawing area in the specified color.
:TPENCOLOR

SETFLOODCOLOR

SCREENCOLOR

_ command fills blue color in a drawing area containing the turtle.
ETFLOODCOLOR

"TFLOODCOLOR 1 FILL

FLOODCOLORFILL

e short forms of the following commands in LOGO.
2. Backward

4. Rightturn
6. Hide turtle
8. Penup

alaln

CICC

-------------------------------

-------------------------------







. Aithmetic Operators « Logical Operators
aithmetic Operations using Operator Commands

: &

We can perform arithmetic operations in LOGO. The mathematical work done !

on numbers is called arithmetic operation. For example, addition, subtraction,
etc. are arithmetic operations.

In this chapter, we will learn to handle different numbers in LOGO. We can also
perform arithmetic operations on them by using different arithmetic symbols. In
Logo, there are two ways to perform these calculations. Firstly, using the
arithmetic operators and secondly, using the operator commands.

ARITHVIETIC OPERATORS
There are basically four arithmetic operators. These are given in the following

table : *

Table : Arithmetic Operators

as) _ _ —— 5%

Addition Multiplication

Subtraction / Division

Arithmetic Operations in LOGO
Using Arithmetic Operators
Th_t‘ results of the calculations done After typing PRINT command, leave
uSing arithmetic operators are seen in one space and then type the numbers
t\}‘lﬁ Recall List Box of The Commander with the desired operator(s).
3 Uldf)w if given independently. ; l
60a£§nt the sum of two numbers, say |= -
B 9, the command is :

6+9
15

Using + operator




Hait Tracs
(B Passe | iany

Step Fesen
Esecipe | Edan

Using - Operator

The'mnhmmthemmmeﬂght side
dmmmm”soperands

- S ... S .- -\

To print the product of two numbers, say 10 and 3, the command is :
PRINT10*3
30

multiplication is * and not x as you do

Using * Operator

To print the quotient of two numbers, say 24 and 4, the command is
PRINT 24/4

6 4 =

" PRINT 24/4 - Halt Trace ?
6

w (A "Powe | S §

: . z y Step Resat

The first number is divided
by the second number. Execute | Edail |
: . T m— e e T T
Using / Operator

ARITHMETIC OPERATIONS USING OPERATOR COMMANDS

Besides basic arithmetic operators, arithmetic operations can also be done using
operator commands.

Print Sum

This command is used to add two or more numbers and display the result.
Instead of giving the *+” sign between the numbers, type PRINT SUM., followed

Book 4




Halt |

r
{[pr1nT (5UM 10 20 30 €] _Pause
- _ Slep

to be written within
ackets (parenthesis). L L Exeose |
Print Difference Using Sum Command

This command is used to subtract two numbers. Instead of giving the ‘-’ sign

between two numbers, type PRINT DIFFERENCE, followed by two numbers
with a space between them.

Print Product (B3 Commander : o & @
This command finds the product of || DIP ' |

PRINT DIPPERENCE 45 5 Halt

- Trace
two numbers. The output is always |82 o2ouer 20 « 3] _Pouse | Swws 1
displayed in the next line. |s0 _ _Sep | Rese ‘
- . L) » -
Print Quotient | P

This command accepts two values )
as input. It divides the first input Using Difference and Product Commands

number by the second input (5 o
number and gives the quotient. 5

r

PRINT QUOTIENT 40 2 - Halt Trace
20
Print Remainder PRINT REMAINDER 11 2 g e
) 1 Step Reset
This command takes two values as | -

input. It divides the first number
by the second number and displays (L&

only the remainder on the screen. Using Quotient and Remainder Commands
LOGICAL OPERATORS

Logo can also work with many logical operators. To perform these logical
operations, a set of special symbols are used, like : =, >, >=, <, <= etc.

- ety

Equals (=) Command
This command compares two |
numbers and checks whether both
numbers are equal or not. The

result of comparison is either true It
or false,

— T TTTNE——

Using Equals Operator

Book-4
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Greater Than (>)
This command compares two numbers. If the number on the left side of the
operator is greater than the number on the right side, Logo displays the resy); ,

‘true’, Otherwise, the result will be displayed as ‘false’.

Less Than (<)

This command also

compares two numbers. - M

If the number on the left Hait b Trace 11

side of the operator is b Sten J

less than the number on @ b — |
the right side, Logo il i ].
displays the result as i 4 |
‘true’. Otherwise, the | Execute | Edal |

result will be displayed e ——

Using Greater than and Less than Operators

as ‘false’.

A. Tick (V') the right option.

1. Print primitive takes ......c..... input at a time.
(a) 1 LI(b)2 [ 193
2. All the arithmetic operators take ............ inputs.
(a)1 [j(b)2 ()3
< O symbol is used for division in Logo.
(a)* L i)/ e+
B. Fillin the blanks with th Z
Enter Remainder PRINTDIFFERENCE  Numbers PR PRINTSU'
1. The operator command used for subtraction of numbers is ..................... :
2. Arithmetic operators Work on ... o
3. The operator command used for addition is ... !
4. PRINT REMAINDER command gives you the ............. of the division of t"*
numbers.
5. The short form of Print Primitive is ......ccccccceouureens

6. To execute any command, press the ................. key after writing a primitive-




r the following questions.
. How do you subtract two numbers in LOGO?

What is the use of LOGO language?

......................................................................................................

\ Can you do addltlon in LOGO without using the PRINT SUM command? If yes,
then how?

-----------------------------------------------------------------------

nnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnn

. What is the difference between PRINT QUOTIENT and PRINT REMAINDER
commands?

-----------------------------------------------------------------------------------------------------------------------------------------------------------------

® Write the command and output for each of the following.

L WA et o N ey i Sl e S A et R A

AT G ST e e et I it e e S Sl e B Rt
Divide 57 by 6 and print the remainder ..

LR T S e et b R B AL A R SRR

PR

®) Practice the LOGO operator commands. Give commands for the following.

B WN R

1. 8+4x16+6-4
2. display the quotient when 36 is divided by 4.

3. display the remainder when 25 is divided by 7.
® Create a formula to calculate the area and the perimeter of a rectangle. Also find
out the answer using Logo commands if length = 3 units and breadth = 4 units.

P e 5



+  Parts of @ LOGO Procedure + Defining/Writing a LOGO Procec_:iure
+  Advantages of LOGO Procedures + Some LOGO Procedure Operations
+  Rules for Naming a LOGO Procedure

Logo is a very versatile language. It can be used for drawing figures i |
displaying values using the Print Primitives. It can also be used for simp.
mathematical calculations.

Sometimes, we need to give so many commands again and again. In such ca«
we can use Procedures. In general term, the word ‘procedure’ refers to
method of doing a particular task. For example, the steps we follow to switch - |
a computer, is an example of a procedure. In LOGO, a procedure is a set
LOGO commands given one after the other to perform a particular task. E..
procedure should always be given a particular name. By using the proced. -
name, we can execute the set of commands that the procedure contains.
PARTS OF A LOGO PROCEDURE

A LOGO procedure has three parts : Title, Body and End.

Title : It allows us to give a name to the procedure. It always starts with
word *‘To’

Body : It contains all the primitives for drawing a desired figure.

End : It contains the word ‘End’, which conveys to the computer that primit
in the procedure are over.

ADVANTAGES OF LOGO PROCEDURES

® Reusability : This is the main advantage of procedures as once we define
procedure, We can use it many times. By simply typing the name. the tur':
creates the image according to the primitives. '

® Speed : As the procedure can be saved, i
commands. So, the execution speed of proc

t takes less time to execute
edures is quite high.

‘ DURE

pital or small), numbers (0-9) and symbol*

RULES FOR NAMING A LOGO PROCE
® A procedure can have letters (ca
@, #, etc.) in its name.




The first character of a procedure should always be a letter.

Tt

_'_”procedure cannot have blank spaces.
‘The procedure name cannot be any LOGO command, such as FD, BK, RT,

T, etc.
® A procedure cannot have colon (:) and arithmetic symbols like (+, -, *, /) etc.

bEF1NING / WRITING A LOGO PROCEDURE

To write a procedure, we follow these steps :
® Click inside the Input Box. Type TO followed by the name of the Procedure,

€.g. TO Square. Press the Enter key.
® A User Input Box appears. Type the commands to produce a square, for

example, REPEAT 4 [FD 100 RT 90]

 ® When all the commands are entered,
procedure for a Square gets defined.

® To run the procedure, type Square in the In
® A square is drawn.
7) For Your quo

A procedure defined within a main

type END and press the Enter key.The

put Box and press the Enter key.

b

[REPEAT 417D 100RT90)

2L 4 Step Raset
SQUARE Exacute Edall

It
o] _omu |

EQUARE - Halt Trace

: fistinad ~ Pause Stalus

SR ey Step | Reset

: Exacute Edall

y Procedure is known as the sub-procedure.
__________________________________________________ -




look at them.

Fi ion) | ¢ Helps to save a procedy. ‘

ile (Menu)—Save (Option)

File (Menu)->Load (Option)

Erase Procedure—Enter

Erase All

Saving a procedure

Loading or recalling
a procedure

Erasing a procedure

Erasing all procedures

in a file on the Hard Dj<)

Helps to load or open 3
procedure from the Har:
Disk.

Deletes one procedure ::
a time.

Deletes all saved
procedures.

Editing a LOGO Procedure
Once a procedure is made, we can open and make corrections in it by follow:".

f For Your Iﬁ@?

We can also edit a procedure by clickr:
= on the Edall button on the window an!
. then following Step 3.

these steps :

® Click on the File menu and choose
Edit. The Edit Procedure dialogue

box opens.

® Select the required procedure from the list and click on the OK button.

® The procedure will open in the Editor window. Here, you can edit

procedure and save it.




!
g a LOGO Procedure l
Erase command is used to remove a procedure from the computer’s memory.
various steps to erase a procedure are :

® Type ERASE” name of the file in the Input Command box.
@ Press the Enter key.

To erase all the procedures from the computer’s memory, we type ERASE ALL =
and press the Enter key.

Saving a LOGO Procedure E
If we write a procedure and save it, it stays in the external memory of the
computer. The various steps to save procedure are :

® Type SAVE” name of the file.1go in the Input Command box.

® Press the Enter key to save the LOGO procedure.

We can also save a LOGO procedure through the File menu. The steps we follow
Eee o

® Click the File menu to select Save As o
® Fix the location of the file.

® Write the name of the file (with. 1go extension) in the File name. B
® Click Save option to save it.

ption. A Save As dialogue box opens.

Loading a LOGO Procedure
We ¢an open a saved LOGO procedure file to work on it again. For this we have F
9 l0ad it first. The various steps to load a procedure are . ;
¥ Click on the File menu and select 9 For Your I H-go

Load. Ap open dialogue box appears. Another way to load a procedure
. the file and select it. + Isto type LOAD” name of the (;“lle

. . in the Input Command box an
tcohck Onit()pen or pl'eSS the El'lter key :: press the Enter _IE‘_EY' __________________ \ =

ﬂ63 % E
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(") before the name of the procedure.

*i* Solve the crossword puzzle with the help of the hints given below.
Across=
2. A segment of procedure that contains commands to —
draw a figure (4) i :
3. First line in a LOGO procedure (5) | £l
5. Remove a procedure from the computer’s memory (5) 12 'D
& 6. A menu option to open a procedure (4) Ly = 1c|
[ 7. Last line in every procedure (3) Br] [ Jc| |
‘Down &
1. A set of commands in LOGO (9) _
4. Stores a procedure on the Hard Disk (4) “1 R
5. A menu option to make corrections in a et ||
A men EplR |
I:l Han
-




| h :Wﬁ'ﬁl;

. ?ﬁxmuur of a procedure should always be a

L_1(b) number [_l(c) name Ik
T '“tltle of the LOGO procedure always begin with
[‘J FD i(b) TO Li(c)* bl
3-. We use the option ... to delete all saved procedures.
(a) FINISH ALL [_I(b) DELETEALL ~ [_l(c) ERASE ALL L
4. We use a double quote before the name of the ............. to give a SAVE command.
(a) file |__.(b) procedure __(c) command )3
B. Fill in the blanks with the correct word.

1. . Is @ group of commands stored together to carry out a job.
Z. A procedure consists of ... parts.

3. We cannot use ........uumnnes to name a procedure.

L —— command is used to remove a procedure from the computer’s
~_memory.
. A file saved in LOGO will have .................... xtension.

Answer the following questions.
1. What do you understand by the term procedure in LOGO?

at are the advantages of procedures?

What are the rules for naming a procedure?

How can you edit a procedure?

Vrite the steps to load a procedure?




TRt etk - ] '} T

% _“"‘-Mmu.‘
® Draw the result of the following procedure ! |

TO CIRCLE

REPEAT 36 [FD 5 RT 10]

END '

TO TRIANGLE

REPEAT 3 [FD100 LT 120] -

END _

® Guess, what each of the following will draw ?
1. REPEAT 5 [FD 50 RT 144]
2. REPEAT 12 [RT 60 REPEAT 3 [FD 30 RT 90]]
@ Write procedures for each of the figures given below. Save all procedures |

separate files in a folder named My LOGO. Edit them by changing the val.:
and save again.

G =
e




<+ MS PowerPoint Presentation <+ Exiting a Presentation

<« Starting MS PowerPoint 2007 <+ Opening a Presentation

* Components of MS PowerPoint 2007  « Adding a New Slide
Creating a New Presentation < Adding Pictures to the Title and Content Slide
Adding Text into a Placeholder < Slide Show

< Saving a Presentation

A presentation is a systematic display of the contents of a topic. It includes text, 4

graphics, pictures, movies, sounds, special effects, etc.

MS PowerPoint is a presentation graphics software developed by Microsoft. It is

the most powerful tool for communicating ideas and information.

MS POWERPOINT PRESENTATION

MS PowerPoint Presentation consists of slides. These are organised and

formatted using various Microsoft PowerPoint features. It is a way of presenting

our viewpoint in the form of text and graphics on the slides. These slides are just

like the pages of a document. It can contain either text or graphics, or both. It

runs continuously in the form of a slide show.

A presentation is helpful to us in many ways :

¢ Using PowerPoint, we can make projects on any topic.

® Teachers can use presentations to prepare their lesson plans.

® People of the business world can use it to present information about their
products or company in seminars and meetings.

STARTING V1S POWERPOINT 2007

® Follow these steps to start MS PowerPoint 2007,
Click on Start > All Programs > Microsoft Office > Microsoft Office

PowerPoint 2007

m—a—n

L



IMicrosoft Office
& PowerPomt2007

Starting MS _P.owerPoint 2007

® On starting MS PowerPoint 2007 a blank presentatlon named Presentation
1 appears on the screen. WP

.__T__l,t'e_ Bar

I Ribbor

Click ta add title

Clickto addsubtitle

Slide Pane|

1T ——— ,.;Is_tatUS ba

MS PowerPoint 2007 Window

[ ] CONMPONENTS OF VIS POWERPOINT 2007
MS PowerPoint 2007 consists of the following components

Title Bar : It displays the name of the presentation on which you are currentl)
working.

Book-4




k Access Toolbar : The Quick Access Toolbar contains commands that
U may want to use quite often. You can place this toolbar above or below the
ibbon. To do so, click on the arrow at the end of the toolbar and select Show

ow the Ribbon option,
To add items to the Quick Access Toolbar, right-click on any item on the Ribbon
and click on Add to Quick Access Toolbar.

~ MS Office Button : The Office Button performs many of the functions that
were available in the File menu of older versions of PowerPoint. This button
allows us to create a new presentation, open an existing presentation, save and
save as, print, send or close the presentation.

Ribbon : The Ribbon is placed at the top area of the document. It has seven
tabs—Home, Insert, Design, Animations, Slide Show, Review and View. Each
tab contains commands arranged in groups.

Slide Pane : In the Slide Pane, you can work directly on individual slides.

Slides Tab : The Slide Tab shows a thumbnail version of each slide shown in
the slide pane. After adding other slides, you can click a thumbnail on the Slides
tab to make the slide appear in the Slide pane. You can add, delete, duplicate and
rearrange slides in the Slides tab.

Outline Tab : The Outline tab displays the text content of each slide. You can
edit your text directly from the Outline view.

Notes Pane : In the Notes Pane, you can type notes to yourself about the
current slide. -

CREATING A NEW F'FIESENTATION

-

3 ’

® Click on the Office Button > A T —
New option. The New ?“‘“‘“ sl
Presentation dialog box will —— q
open. il _z___, '
® Blank Presentation is selected by == 1
default. Click on Create button. = |
® A new presentation with a blank | ==~ ﬁl
slide will open in the PowerPoint | s lj
screen, PSSR e I S Q -
New Presentation Dialog Box




. resel tation is Tit|e Slidu
i displays  the doucj
@ To add a new slide, click on Ney Slig.
|'|  button on the Home tab. '
® To change the layout of active ;.

click on Layout button and selec; |

desired layout that you want. '

Slide yout Optios
ADDING TEXT INTO A PLACEHOLDER
To add text inside the placeholder, follow
these steps : '

® To enter title in a slide, click on the [==
Click to add title placeholder. A M —
text box appears.

® The cursor appears in the center.
Type ‘Computer Designing Cell’.

® Click on the Click to add Subtitle
placeholder. Type ‘Design with e e
Fun’. Observe the change. T Ad

ding Text

w SAVING A PRESENTATIC
-1 It is important to save your work i
| regular intervals to avoid data los
because of any hardware or pow<
failure. Follow these steps to save *
presentation ;

| ® Click on Save button or use Offi¢t
Button > Save option. The 54%
As dialog box appears.

- L’ L Chmrueeurray




Specify the name ‘My Presentation’ in the 1/ For Yo | v% 2 ) '.

File name text box. Click on Save button, In PowerVeist 250 20,

~ The presentation will be saved with the name ¥ the files are saved with
My Presentation, with an extension .pptx.  the extension oyt

EXITING A PRESENTATION .
To close a presentation or exit from PowerPoint, click on Close bution on the
Title bar. — -
® We can also close the s wenn by s &p"; -

presentation by clicking on the jw~ Office Button l“‘.‘.‘..‘,‘._.‘__ ek < = ‘

Office Button > Close option. T .
® To close PowerPoint

application, click on the Office

Button > Exit PowerPoint

option.

Exiting PowerPoint *

DPENING A PRESENTATION
- There are three ways to open an existing presentation, as shown below -

Click on Open button on |
the Quick Access Toolbar,

.
|
\
!
1

. N s

Click on the Open a PowerPoint File
option in Reuse Slides pane. Browse
dialog box will appear.

(

i

Opening a Presentation

Book -4




o Select the picture from the Insert

Picture dialog box by clicking on it | Click to add title
or by typing the filename and clicking | | Gearo e
on Open button. ' s
¢ The picture will appear on the slide. | - @
! “e
|
i
SLIDE SHOW Adding Title and Content Slide

MS PowerPoint provides the option of combining all the slides of a presentation

into a slide show. It is just like the pictures in a photo album. It displays all the
slides in a presentation one by one on the screen.

=3

To run a slide show, you can follow these
steps :
Click on the Slide Show tab and select :
either of the option in the Start Slide
Show group. |
From Beginning -3
From Current Slide - ¥
Custom Slide Show - &= | »
For Uour Info SR Viewing Slide Show
+ To resize a picture click on the Corner Sizing handles. While holding down the
y Mmouse button, drag the sizing handle as per your need and release the mouse

button.

i + Toview the presentation of a particular slide, open that slide and press Shift +F5
' _key combination.

Solve the crossword puzzle with the help of the hints given below.

3. Asingle screen in the presentation (5)

s il"imﬂm.i;.’ oM

------

.................................................................
............................

Book-4
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. Dewne
1. A collection of pictures/graphic files (7)
2. A set of color, fonts [sp| | | |
and special effects (5) it

6. Shows the name of
currently opened
presentation (5, 3)

7. A view of presentation (6)

A: Tic-l:( (v') the right option.

| 1. MS PowerPointis a/an............. software.
’i (a) accounting [ ] (b) presentation [_{(c) word processing
2. The pages in a presentation are called .............
(a) sheets L (b) slides : [](c) documents [
3. The first slide of a presentation is selected as............. by default. |
(a) Title Slide [} (b) Title only ["1(c) Title and Content
" " TP view shows all the slides and the body text in a presentation.
lu (a) Slide Show i (b) Normal C:I(C) Slide Sorter .
. B. Fill in the blanks with the correct words.
pptx  Views g
1. A presentation is a collection of ..., arranged in a systematic orde”
| 2. A presentation is widely used to present i offectively
“ | . "_1,_"1‘0 open PowerPoint file, click on ........... button on the Quick Access Toolbd"

i =




o ;'(b) To open &pep-nup menu
t-click () Todelete aslide
(d) To return to the previous slide

. (e) To go to the next slide

D. Answer the following questions.

1. Whatis a presentation?

-------------------------

2. What is.a slide?

------------------------------

3. What is a placeholder?

4. Which tab contains the New Slide button?

&

© Complete the following table.

-----------

¥ Project Board M.

Create 2 presentation on—Computer : A Magical
Collect information and make an attractive prese



a

N

What is Internet?2 +  Exploring Email .
Uses of the Internet + Setting up an Email Account
Searching on Internet

—

We already know that a computer network means two or more  computer,
connected together with special cables or devices to share information.

WHAT IS INTERNET? i

Millions of computers around the world which
are connected together to share information
from the Internet. It stands for International
Network. When people talk about getting
online, it means being connected to the
Internet. It has many features but is generally
used as away to communicate, use information
tools and find endless amount of information
from unlimited number of sources.

USES OF THE INTERNET

Internet has changed the modern life to a great extent. Every kind of informatior

is available on it. There are many uses of the Internet. Some of the popular uses

of Internet are :

® It provides information/news on any topic.

® It allows us to send and receive messages (text, images, sound, videos
anytime and anywhere.

® We can have video as well as text chat with our friends using Internet. (Vide!
telephony with the help of computer, Internet and web camera),

® Buy or sell new/old goods.

For Your In.go
r An Internet Service Provider (ISP) is the company that gives us access 0 thj
: Internet for a fee. The browser will not be able to display pages unless !

- computer is connected toan ISP, €.8.BSNL, Tata, Airtel, Reliance, etc.

H Book-4 ‘ |
>




¢ Buy airline/railway/movie tickets.
¢ Perform banking operations.
¢ Check exam results.

SEARCHING ON INTERNET

Internet contains millions of websites and webpages. We can find information on -
almost all the subjects and topics available on these websites.

It is not always possible to know the addresses of all the websites that contain
information about any particular subject. We can only remember a limited
number of addresses of websites.

For searching on Internet we have to use search engines and directories. Search
engines are websites on the Internet which provide the facilities to search on the
Internet to find information.

Search Engines

Internet search engines are those websites which search information for us
according to the words or terms we have given.

Most people are primarily interested in tools for finding information on the web.
Originally, there are two kinds of search services on the Internet -

® Directories

™M

® Engines
‘ (S}omc of the popular searc;h engines are : 5 For Uy I“go
oot = EODiEc.com Larry Page (R) and Sergey Brin (L)
MSN WWW.msn.com : are the founders of Google.
' Yahoo www. yahoo.com =TT p-
Askjeeves www.askjeeves.com FErTm—ug :
Search engines should be our first ;0;.‘ e .
¢hoice when we know exactly what R
Wwe are looking for. e y

Imugot ko johue e g

Suppose we want to search jokes on
¢ Internet. Open a search engine

“ith our browser. For example b o
ke, “WW.google.com and type ok T
S In the space provided for e i hngoawe

; lﬂﬂ‘l-l-ﬁnlﬂ.

w .
Nting search terms.




In this way we can search
other things also. We can
scarch  for books, games,
news, songs, movies, pictures,
etc. While scarching, we must
carefully choose the search
terms,

For example, in the above
case of jokes the search engine

bﬂﬂ*“
School Jokes - Furmy School Jokes !

é > oo . oo R i School For Trousig
provides us all the links about e e e e el |
’ - y Tonchors doters - it Johan Juin - Groresvos Joes Fiut 5t he 0 Changs bae
jokes. Now suppose we want s lan it
Jokes only about school. For s

this, we can type school jokes. School Jokes Search Option

We can use different searching options to effectively search matters related to

any topic. We will know about advance searching options and the working of
scarch engines in higher classes.

[ ——

Open any search engine.
Search for ‘Computer books for kids’. Note down the number of links.

® Now search for ‘Elementary Computer books for kids’ and note down the number of links.
®  Use t_he__glgpvg_gg_azph terms in different search engines and find the differences.

EXPLORING EMAIL

Email stands for electronic mail. It is one of the most widely used applications of
Internet. It is a fast and convenient way to communicate with others. We can use
Email to :

Send and Receive Messages : We can send an Email to any person who has
an Email address. The message arrives in the recipient’s Email inbox within
seconds or minutes irrespective of his location. We can receive messages from
anyone who knows our Email address. We can also read and reply to thosé
messages. »
Send and Receive Files : In addition to the normal text-based Email, we ca
send almost any type of file in an Email; including documents, pictures &
music. A file sent through an Email is called an attachmen. '
Send Messages to Groups of People : We can send an Email to many p
at the same time.




]
Em: il is Free : Unlike sending a regular letter an Email does not
mp or fee and the town where the recipient lives. The only charges that
> pay are for the Internet connection
, Email Address : An Email address consists of a user name (a nickname we .
- choose, not necessarily our real name), the @ sign, and the name of the website
which we are going to create the Email id. Example E

info@brilliantbooks.co.in

For Uour IN.EO‘
4+ Email address of every person is unique and no two

persons can have the same e-mail address.
| ¢+ An Email address does not contain any space and is
always in small letters.

| 4 Sabeer Bhatia, the founder of Hotmail, the first Internet

o ki et g v W N

SETTING UP AN EMAIL ACCOUNT

To receive and send an Email we must set up an Email account. Your teacher will
help you to set up your account. Most Email addresses are simple, €.g.

someone@somewhere.com
Write your Email address below. Learn and remember it.

--------------------------------------------------------------------------------------------------------------------------------

Receiving and Opening Email I8
® Open Microsoft Office Outlook S

2007. B A s
% Click inbox to see the messages T show I —
; Super Cool Stuft
o e ave ?)een s ; with a 33 beside them.
Double click on the files/messages B O Personal FoR
to open it. Goiwim L ‘




B e —

Replying to Email

® Microsoft Office Outlook 2007 will fill in the To... box, automatically ,,;,
the sender’s name. : |

® Microsoft Office Outlook 2007 also fills in the Subject : box with Re - .,
original subject.

Click the space on top of the original message and type the reply :

Dear Ashish,

Yes, my daddy has bought me some adventure storybooks. You can cor. -

my house and select any of the books that you like.

Regards,

Vihaan

® Click to send your reply.

Yes, my daddy has bought me some adventure storybooks. You can come to my house and select any of the
books that you hike,

| + Send an Email to your teacher telling him/her about the lessons which you enjoy
- the most.

+ Send an Email to a company to ask about one of its products. You could choose

sweet company or a fast food chain, and ask them what they are doing to make

l
|
f healthy snacks. Do a screen grab of any replies.
X~ 2la e —

Book-4 .
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. '. (v) the right option.

1. Whatis the largest network of computers spread across the globe called?
(a) Multimedia [ (b) Internet [} (c) cable Network || '
2. - i a special program to open websites. ;
(@) www . (b) Web Browser 1 (c) Web page L
L, . is regarded as the founder of world wide web.
(a) Sabeer Bhatia || (b) Tim Berners-Lee || (c) Sergey Brin et
4. . is one of the most popular search engines and has been founded by
Larry Page and Sergey Brin.
(a) Yahoo 1 (b) Google __1 (c) Bing el

B. Fill in the blanks with the correct words.
m&&plomr Email www Google Chrome Web Browser Home Page

B
A is a software that is used to access information on the Internet. !
2. e 1S @ collection of various websites.
B and . are the two most popular web browsers.

4. The first page of any website is known as .....c.ccceeeees ;
B s is one of the most widely used applications of Internet. ‘

C. State whether the following sentences are true or false.
1. A website is a special program to access information.
2. An Email is sent through the Internet.
An ISP is the company that gives us access to the Internet for a fee.
The world wide web is not a part of the Internet.
The Hotmail was the first Internet based free Email.

D. Answer the following questions.
1. What is Internet? Explain any two of its uses.

i =

was an AR EESARRREERR BT RARRS




.......................................................................................................................... e t.‘i'l“‘u

4. What do you mean by Email? g

2 o e e in tickets through the Internet. H Py
i 5. Agrim’s father wants to book train . _ e asks A
v to open the website of Indian Railway. How will Agrim open it ang hely v
'i‘ father book tickets online? |

w N R R T L L L LA L L L '.'.-.......‘."..‘\

¥ """

© Make a project report on ‘Uses of Internet’ by discussing with your teache,
parents and classmates. '

&
. ®) Visit the website of the newspaper which is subscribed at your home.
r r ®) Does your school have a website? If yes, open it.

Book-4




:)J ” < L Microsoft”

. Quick Glimpse of ga.Office2010

nd

; omce Ribbon Office Ribbon

 — - p

uJ - Gt I VA a B B B OV (] s ARG Asmce AQD A ::-
""";:—__ BB dnw VA EEEE G R """"._“"‘“" asngt Muang) Wm g o s tma

Ohptoars - Fend 5 e 5 L ity

8 _, The Ribbon has replaced the traditional menus which were present in the previous
~ versions of MS Office. The Ribbon commands are organized into tabs that group related
commands together. The Ribbon has three parts : Tabs, Groups and Commands.

3 Macrasalt Ofixce 2010 - ‘

"y

J
Ju

5 o : i = ortarl ™ i resall
\ L@t _taoe_veacp S e Commands are

?Bﬁs are placed at | g “ Oy ol : @:‘ T 2“ : H arranged in
! . i - X AW A- 15- &-E- |1 i
*" the top of the R, § = " =i - different groups. A
~ Ribbon. Each Tab  H b e e eeiieeed  COTRNAN] cantBe 3
" represents core (Groups are sets of | button, a menu, or

tasks we do in a Leiwteg commands.) a box where we

given program. enter information.

example, the Home tab contains the commonly used commands for writing
Mcnts : font formatting commands (Font group), paragraph options (Paragraph

group) and text styles (Styles group).

e Tab -

' M~ = 1 .
&/ File . Home | Inser

-_-__1m _— ﬂ '* e ) _.

. [ PP S R !° ¢ oM o)

. “ I} Calibri (Body) N:tc J B 7 U-&
e || Clighoara r

- e 4 ""‘**‘ [ “:. e

In Office 2007 In Office 2010

-
on 1n

1ce

the MS Office 2007 has been replaced by the File tab in the

_ 2010). On clicking the File tab, the same basic commands,
ble in older versions of Office are displayed along with some new




Quick Access Toolbar '
ds of our choice to the Quick Access Toolbar,

We can casily add the comman
Toolbar 18 located

- N p
W W7 W Qulck Access Toolbar ™ o g
o P Fage LA LT Bhammr gy T

The Quick Access -
above the Ribbon, on top of the File tab. w0 iy B¢ W M T ey,
A 3 0 i‘k @ Trannhie anguesge  Pew b o 3 Ve Martug ‘;ﬁ%
The commands placed at the QuI¢ e P [ - - P

T IR Lamnect) B L L N —— I

! r
ight-click on the u P —— .
= Tracking group to make D Gk Ao

| | further changes In Quick IS
| Access Toolbar. Mgt the Bivaom

Access Toolbar are always visible on the
Word screen. By default, it shows the
Save, Undo and Repeat commands.

Using Microsoft Word 20 10

Creating a New Document
@ Click on the File tab and select New option. Or

® Press Ctri+N.
E?.!*WEEL N— - " . i

= @ 5
e )

reating New Document

S0
Home et
[l Sawe

Opening an Existing Document o
® Click on the File tab and select Open option. Or ;uw
o Cuse

® Press Ctrl + O on the keyboard.

Saving a Document b

® Click on the File tab and select Save option or Save As. Or B
prnt
save 81500

® Press Ctrl+ 8. Or
® Click on the Save icon B on the Quick Access Toolbar.

Exiting a Document
® Click on the File tab and select Exit option. i
[

Help




| ® Select the text and click o

|

Using Cut/Copy/Paste Options

® Select the text. Click on
Cut/Copy command on
Home tab. Place the
insertion point where you
wish the text to appear.

®  Click the Paste command
on the Home tab.

Changing Font

LA™ B O | Change Font
- Mome | vient Page | Jome '."" Page Layout Reterencer
A 3 Cut ) = o |- 1_ a" T A A Ar #
Ade— Copy | =
; > the x, 3 Font Siz
o - Paste Cambriy s roneSE8 Oleadngs)
‘ o 'm. Calibr Boay
[ 5 a) b | narees
|.‘,,,;;;‘;,,,_‘,,wn]- T lvamirocuai |
| T R
_:-_. e I A=

7 -

®  Select the text to change the font. Click the Home tab.

® Click on the dro
Font group.

Changing Font Size

® Select the required size b

Size box on the Home tab

® Click on the Increase [A] or Decrease N

Changing Font Style (Bold,

. Or

Italics & Underline)

[Change Text Color)

: Cha n-ge_Li-n:e Spa ci;ug

Calibri Body) '!u “" A X | As* \\_[Q} :

(D E-E-% F ol TR |
e |AE-A-HEawi ST
. Font __f? a I‘,L Par !Iquph
LCh'angt_'g'For;t Style ] Highlighting Text ;_Change Text Alignment |

commands in the Font group.
. ® Just select the text and the
_ displayed along with, Select the
- -hanging Text Color
¥ Select the text and cJ;

| Btomm. ;_meﬂome tab.

Or
font tools

ck on the Font Color drop-down arrow £\ -

select the text and the Fo

n the B, 7 and U

required command.

p-down arrow| ~|next to the Font box Calibri Body) ~ from the

y clicking on the drop-down arrow next to Font

Font Size buttons in the Font group.

will be
Home taby,

e LI N

BINEY-A-v¢
(limmm;—:ﬁ-:n
Spwenr, Sebect the text and click on the Text N

nt tools will be displayed along with.

required color from the Font Color menu.

in the Font

ghlight Color button in the Font




- Lad -_— B @02 ATsssee— .

Changing Text Alignment

® Click on the Home tab.
y of the Alignment buttons in the Pypy

® Select the text and click on an grap)
group on the Home tab. s L o [T ’

Changing Line Spacing (4] 128 “ e

® Select the text. . I in

® Click on the Line and Paragraph 28 B
Spacing command in the o R o
Paragraph group on the Home tab. [ s mosn 8

® Select the desired spacing option e ‘ o g

Line Spacing Applying Border & Shading

from the drop-down menu.
® You can also select Line Spacing Options to open Paragraph dialog boy |

and can adjust the line spacing with even more precision.
Applying Border & Shading

® Select the text.
® Click on the Border button in the Paragraph group on the Home tab. Select

the required border from the drop-down list.
UBING MICROSOFT POWERPOINT 2010

Rlbbon

— Qun:k Access Toolbar

3 . ::' > ANiS E-E- 1w lE g:::’;':'" E_\Ltggg +J:‘:m_“ ::_
-Lﬂ_.nxna‘.vhmltnil- < El'\‘\’\ﬂ}ﬁ'*"""'n"-'w-'"' 3w
5 ront ) Magep Fa =
(Dialog Box Launcher ..> Opens a related dialog box o task pane) " Group Name
Adding a New Slide - —
® Click on the New Slide button in Slides | e = =
| Layout . A

group on Home tab. It default layout “Title
and Content”. Or
® Click on the drop-down arrow of the New
Slide button. You can select the layout for
the new slide from the displayed menu. Or | |
® Click on the Layout button to select and change the slide layout.

Slide Show
® To view a presentation, simply click on Slide [E=

Show tab and Start Slide Show group. Or
® Press F5 Key. Or
® Click on Slide Show button on the Status bar.
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ﬁ\\ Type the following paragraph in MS Word and perform the instructions given below.

1. Change thetitle of the passage to capital letters.

2. Change the font color of the words Writer to red.

3. Change the font style to Comic Sans and the font size to 18 pt.

4. Choosethenounsinthe paragraphand make themin green color.
5

. Save the document in the name of Why I Write in a folder of your name at the
desktop.

Why | Write—George Orwell :

From a very early age; I knew that when I grew up I should be a writer. During my |
adolescence, I tried to abandon this idea. Howev

er, | knew that | was trying to
escape from my true nature. | knew that eventually

Iwould become a writer. :
I was the second among the three children of my parents. [ barely was my father !
before I was eight. For this and other reasons, I was somewhat lonely. | soon '
developed an unpleasant behaviour that made me unpopular throughout my |

school days. I had the lonely child’s habit of making up stories and holding |
conversations with imaginary persons. In a way, my loneliness inspired me to !
write.

s

- -

G‘Eate dpresentation of |0 slides on “Types of Pollution’ in MS PowerPoint using the

1. StartMs 2. Giveatitle tothe firstslide
- 3. Createanewslide 4. Typetextrelated to the topic
6. Insertpictures related to the text
8. Applyatheme

10. Save the presentation as ‘Pollution’ on
your desktop

nds MSW Logo and find the result.

2. REPEAT10[FD90RT36] .
30RT 150] 4. REPEAT6[FD45RT60]

bl
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10.

1.

12.

' T Personalities

Charles Babbage : He is known as the father 0f computers. He des;
automatic calculating machine in 1822. He called it Difference Engine.

Bill Gates : The Co-founder of MICROSOFT and one of the most richest persons i the
world. He developed Windows for general purpose computer systems.

Mark Zukerberg : The Co-founder of Facebook — The most popular Socig
networking site. He is the world's second youngest self made billionaire.

Steve Jobs : He was the Co-founder, Chairman and CEO of the Apple Inc. He has
been described as Father of the Digital Revolution. |
Larry Page and Sergery Brin : They founded Google, the most famous seqrehy
engine on Internet.

Narayan Murthy : The Co-founder of INFOSYS — The most respected Indian 1
Personality.

Vinod Khosala : The Co-founder of Sun Microsystems which gave us Java.

Tim Berners-Lee : The man who invented the world wide web (www.

Vinton Gray Cerf : He is known as The father of the Internet’. He is well-known for
his pioneering work on nefworking.

Jerry Yang and David Filo : The founders of Yahoo Inc. Yahoo is best known for ifs
web portal, search engine and other services.

Vinod Dham : He is popularly known as the ‘Father of Pentium’ for his contribution in
the development of the Pentium Processor from Intel.

Sir Christopher Latham Sholes : He is regarded as the inventor of QWERTY
keyboard layout.

Dr. Engelbart : He is the inventor of the computer mouse.
Bill Kendrick : He is the lead developer and designer of Tux Paint.
Sabeer Bhatia : The founder of Hotmail, the first Internet based free Email.

aned o




/'-_.

B \Word inns |
&= VVOrd JNDEX /
. AU: It stands for Arithmetic Logic Unit. If Is responsible for doing various arithrmetic

operations.

2. CU : It stands for Control Unit. This unit works like a fraffic policerman and manages
all the operations of a computer,

3. MU : It stands for Memory Unit. This unit stores instructions and data (inforrmation)

4, RAM : RAM is Random Access Memory. It stores the information ternporarily

5. ROM : It stands for Read Only Memory, It is permanent in nature,

6. Desktop Background : It is the background image that is used to decorste the
deskiop.

7. Screen Saver : It is the image that you see when the computer is left idle for
somefime.

8. Shortcut : A shortcut is an icon that provides an easy and quick way 1o open any
application or software that we use frequently.

9. File : It is a collection of related information,

Shapes Tool : It is used to draw various filled and unfilled polygonal shapes

Smudge Effect : It is used when we draw water bodies in our drawing. It is used 1o
mix fwo different objects smoothly.

Waves Effect : This effect is used to wiggle any picture side 1o side (horizontal)
Wavelets Effect : The wavelets effect wiggles any picture up and down (vertical)
Formatting : It means changing the appearance of a document to make it atfractive,
Font : A font is a set of letters and symbols in a particular design and size,

Font Size : The size of the fext is called the font size.

Bold : It is the darker printed fext so that words and phrases stand out on a page.
Halic : Italic text is slanted. I is mostly used for emphasis.

Underfine : Underline text has a line under it.

Superscript : Superscript reduces the size of the fext and raises it fo the Jop of the
Current line, ‘
Subseript : Subscript is a text style that reduces the size of the text and lowers it o the
n botiom of the current line,

B Text Alignment : If refers fo the posifioning of fext on a page. Lo
@ Une Spacing : If is the vertical distance between successive lines of the 1€

document

=3

SISIFTEEER

u W’Am is @ small graphic symbol that sets off an item in O liﬁ;i&d s opplied 10
" Cap Effect : In order fo give graceful look fo a document, this &

the first letter of the paragraph.

1 89 )
‘ B




26. LOGO : It stands for Languages of Graphics Orienfed. It is O simple corng,g,,
language for kids. :

REPEAT Command : This command is used 1o repeat some steps in a progrorn,

Primitives : Primitives are the commands fo move a turfle around the screen ar

draw different figures.

Polygon : It is the name for all closed figures with a certain number of edges,

FILL Command : It uses color of the brush 1o flood an area.

Pixels : These are the smallest picture elements.

SETPENCOLOR Command : It gives ink color 1o the pen of the furtle.

Arithmetic Operation : The mathematical work done on numbers is called arithrrer,

operation.

Procedure : The word ‘procedure’ refers to the method of doing a particular task

Sub Procedure : A procedure defined within a main procedure is known os the sz
procedure.

ERASE Command : This command is used fo remove @ procedure from fhe
computer’s memory.

Loading a Procedure : Opening a save LOGO procedure file 1o work on it again is
called loading a procedure.

Presentation : It is a systematic display of the contents of a fopic. it includes tex,
graphics, pictures, movies, sounds, special effects, efc.

Slides : Slides are just like the pages of a document.

Quick Access Toolbar : This foolbar contains commands that you may use quite
often.

Slide Pane : In the slide pane, one can work directly on individual slides.

Slide Tab : The slide tab shows a thumbnail version of each slide shown on the slide
pane
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Tab : The outline tab displays the fext content of each slide. One can edit texd
directly from the outline view.

Slide Show : Slide show displays all the slides in g presentction one by one on the
s

“l.qwt : It is the arrangement of fext and graphics on the slide.

Internet : It stands for International Network. Millions of computers which are
connected fogether 1o share information from the Internet.

ma Provider : This is the company that gives us access to the Inteme!

rch Engines : Infemet search engines are those websites which sea’c
-forusoccordingtomewordsortarmwehovegiven.

nail stands for electronic mail. It is one of the most widely used applications
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(A) Tick () the right option. ‘*: ': :
1. 1KBisequalto 7
(a) 1000 bytes L_l(b) 1240 bytes [_|(c) 1024 bytes L .v» i
2. A is a collection of relevant files stored together on some ) " '
storage devices. 2y \
(a) icon L1 (b) folder L1 (c) desktop L] *7
3 is not an operating system. s " -
(a) MS Windows 7 [ (b) Linux L1 (c) WordPad ] r—": ’
(B) Fillin the blanks with the correct words. ‘ : .: .
.- i jump arrow Pendrive shortcut output _J' :. :
R is an icon that provides an easy and quick way to open | "‘ -
any application or software. . B
2. The printer and monitor are ... devices. < y ' ;
3. Ashortcuticon has a small .....micensnnn on its lower left corner. 8" pu
4. .&Mh drive is popularly Known as ... . At
swer the following questions. . ". >
s the difference between copying a file and moving a file? i 3 ]
ve two difference between Dot-matrix printer and Inkjet printer? SN
it

e following and write their names.
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Note : All questions are compulsory.

A. Tick (V') the right option.
l 1. By default, line spacing is set to

Magic effect is used to trace edges from the already draw!

(a) single [_1(b) double [1(9) 15 ]
2. sets the color of the drawing area in the specified color.
(a) SETSPENCOLOR -
(b) SETFLOODCOLOR i
(c) SETSCREENCOLOR L
3. We can create a dripping effect of wet paints using the ____ effect of
magic tool.
(a) Drip [ 1(b) smudge [_{(c) Foam L]
i 4. Where are deleted files or folders kept on the desktop?
(a) My Computer __(b) Recycle Bin | _|(c) MyDocuments _
5. Thereare__ _different shapes available in the sub-toolbar of the shapes tool.
(a) 16 [ 1) 18 [ 1) 20 L
B. Fillin the blanks with the correct words.
¥ is a medium through which we can interact with the hardware,
using software.
2. .. command picks up the turtle pen.
‘ i -Is the vertical distance between lines of the text.

image.

_ 5. - tool is used to create and open a new file in Tux Paint.
.; C m the following questions.

1. Write the steps to print a picture in Ty Paint,
2.  Explain any two features of Windows 7,
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available in MS Word 2007,
4 Why do you use REPEAT Command?
5. Whatis LOGO? What are LOGO primitives?

p. Write the full forms of the following commands in LOGO.

What do you understand by text alignment? Name the types of

““anum

1. PE g ST
3. C 4, pU
5. HT 6. HOME

. Llabelthe different components of MSWLogo inthe following picture.

Halt

'« Peuse | Stats

’ Step
Execute
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b Note : All que mmn are compulsory.
L 4
v (A) Tick (v) the right option.
g " 1. All the arithmetic operators take inputs.
bar. & (a) 1 [1(b) 2 [ 1(c)3 O
; s s . 2. We use double quote before the name of the to give 3
o - SAVE command. I
. ¥ "", (a) file |_|(b) procedure || (c) command il
| e .: . 3. is not a secondary storage device.
S "" (a) RAM [_l(b) DVD [_1(c) Flash Drive L]
« &*, « (B) Fillin the blanks with the correct words.
; : : .' I IRASI" PE Enter " Insert
g :: 3 1. To execute any command press the .............................. key after wrltmg a
= primitive
o s : :; : S L R, command is used to remove a procedure from the
Al computer's memory.
; | 2
- 3. Toselect the Drop Cap option, click on the ..........oooooovooooo.... tab.
a .’
f‘ 2 - e makes the turtle's pen act as an eraser.
»s ®4. (C) Answer the following questions.
« &
A ‘4"@ 1. Whatis the difference between PRINT QUOTIENT and PRINT
v "' e REMAINDER commands?
¢ a
Yr4 o 2. Write the steps to load a procedure.
re " (D) Match the icons to their functions,
“‘ s & 10 . .
“aealy . ’ « (3) Gives a dripping effect to
£ R our drawing.
v 4 « (b) Adds white noise to our
4 Y
., drawing,
v
: « () Adds the foam effect

wherever you want.
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Marks ...,
Note : All questions are compulsory.
A, Tick(v)the rightoption,
) F— isnotasecondary storage device,
(a) RAM Ll (b)DVD Ll (c) Flash Drive ]
2. Thepagesinapresentation are called
(a) sheets L (b)slides L ()documents ||
3, Thetitleofthe Logo procedure always begin with
(a)FD L1 (b)To L1 (9* ]
B s isaspecial program to open websites.
(a) www _ | (b)webbrowser | (c)webpage L]
B. Fillinthe blanks with correct words.
1. A isacollection of related information.
2. Theshortform of Print Primitive is ............o........ :
3. Torunaslide show,youcan pressthe ... key.
4. s iS 2 cOllection of various websites.
Be i effect is used to mix two different objects smoothly.
- €. Matchthe following:
(a) TimBerners-Lee

1. Harddisk
¢, Tuxpa (b) Secondary memory
g 9 (c) Vectorgraphics
mrofworldmdeweb (d) Twoinputs
fther the following statements are true or false::




2. Whatisthe use of Shapestool?
3. Whatis font? How will you change the fontin your document?
4. Whatistheuse of LOGO language?
5. Whichtab contains the New Slide button?
6. Whatisthe difference between a web page and a web browser?
F.  Complete the following words:
| 1. D_gi_al 2. W_nd_ws
l 3. F_rm_tt_ng 4. D_aw_ng
o P_et_tu_e 6. A_im_ti__n

G. Labelthedifferent components of MS Powerpoint 2007 in the following picture.
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Computer Concepts is a diligent effort to provide the best and %
comprehensive understanding of the subject. .

Lesson Extract outlines the objectives of the chapter.

Chapter Content starts with an engaging introduction. The textis _'f;' :
supported with pictures and relevant screenshots. “

| For your Info (Information) gives extra and useful information for *
memory reinforcement.

Time to Drill interspersed within each chapter to check the
alertness of the students. a3

Lab Visit provides more activities that can be doneinthelab.

Test Papers provide sample questions to assess students’
understanding of the concepts learnt. i

A series that will prove to be a treasure house for overall digital
development.
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